Servicios Laboratorio de Calidad Codigo: SLC-1013
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detector de masas de triple cuadrupolo AGILENT GC Fecha: 03/07/2025
IDEAM 7890B/QqgQ 7000D
1. Objetivo

Establecer los lineamientos y procedimientos para el manejo operativo del cromatégrafo
de gases Agilent 7890B acoplado al detector selectivo de masas de triple cuadrupolo
Agilent 7000D que permitan la puesta en funcionamiento del equipo.

2. Alcance

Este instructivo inicia con el alistamiento y encendido del equipo, se presenta de manera
detallada informacion que permite realizar el acondicionamiento, optimizacion,
calibracidn (autotune), creacion de métodos en el cromatdégrafo de gases Agilent 7890B
acoplado al detector selectivo de masas de triple cuadrupolo Agilent 7000D y posterior
operacién del equipo para la determinacién de los compuestos de interés.

3. Definiciones

e Inyector: mddulo de introduccion de la muestra al sistema cromatografico
utilizando una jeringa. La muestra inyectada es vaporizada y conducida a la
columna capilar por medio del gas de arrastre.

e Cromatografia de gases: método de separacidon de mezclas complejas a través
de la reparticién de los analitos entre la fase estacionaria y la fase moévil (gas
inerte).

o Espectrometria de masas: es una técnica analitica mediante la cual atomos o
moléculas son ionizados y separados por su relacién masa/carga (m/z).

¢ Cuadrupolo: analizador de masas que consiste en cuatro barras paralelas que
utilizan las trayectorias en campos eléctricos oscilantes para separar los iones de
acuerdo con su relacién m/z.

e Celda de colisiones: es un hexapolo de alta presién con una aceleracion lineal
ajustada para optimizar la fragmentacién de los iones utilizando un gas inerte que
puede ser nitrégeno o argon.

e Columna: tubo capilar de silice fundida recubierto con poliamida y fase
estacionaria apolar en donde ocurre la separacion de los compuestos.

e Tuning: proceso de ajuste que optimiza la eficiencia del espectrometro de masas.
El objetivo es maximizar la sensibilidad manteniendo una resolucidon aceptable,
asegura la asignacidén de masas precisas y proporciona las abundancias relativas
deseadas en el espectro.

e Autotune: ajuste automatico de los parametros del espectrémetro de masas para
el compuesto de calibracidon, en este caso, perfluorotributilamina. Cuando se
ejecuta el autotune, un ajuste y calibracién son realizadas automaticamente con
los parametros cargados en el archivo del tune.
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4. Siglas

e GC: Cromatografia de gases
e MS: Espectrometria de masas
e MS/MS: Espectrometria de mases de triple cuadrupolo

5. Documentos relacionados en el SGI

SLC-FO07 Formato control diario manejo de equipos
6. Desarrollo de la actividad

6.1. Aspectos de salud y seguridad laboral

Utilice los elementos de proteccidon personal, para operar el equipo. Gafas, guantes de
nitrilo. Revisar el Manual del sistema en seguridad y salud en el trabajo — SGSST E-SGI-
ST-MO0O1.

En la Tabla 1 se presentan los simbolos de seguridad que se utilizan en el Cromatdgrafo
de gases acoplado al detector selectivo de masas de triple cuadrupolo Agilent GC 7890B

/QQQ 7000D

Procedimientos operativos o practicas no realizadas de forma correcta podrian resultar
en dafo del instrumento o pérdida de datos importantes. No proceda mas alla de un
aviso de precaucion o peligro hasta que las condiciones indicadas se entiendan y sean
cumplidas. Realizar el mantenimiento y verificaciéon del equipo con los elementos de
proteccion personal evitando introducir contaminantes en el sistema que afecten el
funcionamiento del instrumento.

6.2. Equipos, reactivos y materiales
6.2.1. Equipos

e Sistema de vacio

e Interfaz GC/MS

e Fuente de iones.

e Electrénica.

e Cromatdgrafo de gases (GC) serie 7890B.

e Detector Selectivo de masas (MSD), Agilent Triple Quad serie 7000D.

e Dos analizadores de masas cuadrupolares con calentamiento independiente.
e Hexapolo simple, cdmara de colisiones.

e Muestreador automatico de liquidos Agilent 7693.

e Fuente de gas.
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6.2.2. Materiales
Viales de cromatografia con su septa y tapa

6.2.3. Reactivos
Agua ultra-pura.
Metanol Grado MS
Acetato de etilo grado MS

Limitaciones e interferencias

Se requiere que el instrumento sea operado por un profesional con experiencia
relacionada en la técnica de cromatografia de gases acoplada a detectores
selectivos de masas.

El inyector, horno, detector o bomba mecanica pueden estar lo suficientemente
calientes como para causar quemaduras. Enfrie las zonas a una temperatura de
manipulacién segura antes de continuar.

No encender el horno a altas temperaturas hasta asegurarse que el gas de arrastre
estd corriendo por el sistema. La temperatura del horno y de la interface nunca
debe estar por encima de la temperatura maxima permitida de la columna.

Verificar la presidn en el cilindro de helio. La valvula del cilindro debe estar abierta
y la presién mayor de 500 psi, presiones menores pueden introducir interferencias
y contaminantes en el sistema. Si la presidon es menor se debe cambiar el cilindro.
Los gases (He y N2) deben ser de calidad cromatografica, se recomienda que la
pureza del gas sea al menos grado 5.0 (99.9995%).

Si el espectrémetro de masas esta conectado a una fuente de alimentacién, incluso
si el interruptor de alimentacion estd apagado, existen tensiones potencialmente
peligrosas, por tanto, es recomendable que esté conectado a un sistema de
alimentacién ininterrumpida (UPS, Uninterruptible Power Supply, por sus siglas en
inglés) que permita proteger el equipo en caso de fallas generados por picos o
caidas de tensién o interrupcion de la energia eléctrica. El voltaje de operacién es
de 120VAC £ 10% o 220VAC % 10%.
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6.3.1 Condiciones ambientales

Temperatura ambiente recomendable para la operacién del equipo debe estar en el
intervalo entre 13 a 35 °C y la humedad relativa entre 25 - 95 %. Ambientes demasiado
secos (por debajo del 25%) de humedad relativa pueden generar errores o fallas en el
equipo. De la misma forma, ambientes demasiado humedos pueden producir
condensacién sobre los componentes del instrumento.

6.4. Control y aseguramiento metrologico

El aseguramiento de la calidad del funcionamiento del equipo puede ser verificado a
través de las calibraciones y ajustes realizados por el sistema: check air and water,
autotune y check tune. Debe realizarse el cambio periddico de consumibles que se
desgasten y el mantenimiento preventivo del equipo.

6.5. Desarrollo

6.5.1. Principio del método

La cromatografia de gases (GC) es una técnica de separacion en la que los componentes
de una mezcla se reparten entre dos fases: una fase estacionaria, con una grande area
superficial y, una fase movil, que es un gas inerte. En esta técnica la muestra se vaporiza
y es transportada por la fase mévil conocida como gas de arrastre (usualmente helio,
hidrogeno o nitrégeno) a través de la columna que contiene la fase estacionaria. Los
componentes de la mezcla o analitos son separados con base en sus presiones de vapor
relativas y su afinidad por |la fase estacionaria y posteriormente llegan al detector, cuja
respuesta es mostrada en el monitor (MILLER & McNAIR, 1997).

La espectrometria de masas (MS) es una técnica que permite estudiar las masas de
atomos, moléculas o fragmentos de moléculas. El anadlisis por espectrometria de masas
permite obtener espectros de masas, en el que las moléculas gaseosas se ionizan, los
iones se aceleran en un campo eléctrico y posteriormente se separan segun su relacion
masa/carga (m/z). En el caso en que las cargas sean igual a +1, la relacién m/z
correspondera numéricamente a la masa molecular, o masa de los fragmentos (HARRIS,
2010).

La cromatografia de gases acoplada a la espectrometria de masas (GC/MS, gas
chromatography coupled mass spectrometry, por sus siglas en inglés) constituye una de
las técnicas de mayor interés para el analisis de mezclas complejas por su capacidad de
separar, identificar y cuantificar los analitos. Para que una sustancia pueda ser analizada
por GC/MS debe ser suficientemente volatil y térmicamente estable.
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Un espectrometro de masas unido al cromatdgrafo de gases es conocido como detector
de masas o detector selectivo de masas (MSD, Mass Selective Detector, por sus siglas
en inglés). La espectrometria de masas se basa en el analisis iones que se mueven a
través de vacio. En GC-MSD, generalmente la ionizacion de la muestra ocurre en la
camara de ionizacién o fuente de iones mediante la técnica clasica de ionizacidn
electréonica o impacto de electrones (EI, electron ionization or electron impact), también
puede ser utilizada la ionizacién quimica (CI, chemical ionization).

En la EI un haz de electrones producido por un filamento de tungsteno cargado con alta
energia bombardea a las moléculas retirando un electréon de la molécula en fase vapor
generando pérdida de la neutralidad. De esta forma, son producidos iones positivos, iones
negativos y especies neutras. Los iones positivos se dirigen al analizador por repulsion
electrostatica, los demas son expulsados a través del sistema de vacio. Los iones
positivos se analizan por un analizador de masa que controla el movimiento de los iones
a medida que viajan al detector para convertirse en sefiales reales. En la EI los electrones
tienen tanta energia (70eV) que se producen muchos iones fragmento, producto de la
energia excesiva que hace que la molécula se fragmente.

Uno de los analizadores de masas mas usados en el acople GC-MSD es el analizador
cuadrupolar, un analizador de barrido conocido como cuadrupolo o filtro de masas. Un
cuadrupolo esta formado por cuatro barras solidas paralelas en la direccion de un haz de
iones. Un voltaje de corriente continua y una radiofrecuencia son aplicados a las barras,
generando un campo electrostatico oscilante en la regién entre las barras (STASHENKO
& MARTINEZ, 2010).

Dependiendo de la razén entre la amplitud de la radiofrecuencia e el voltaje de la
corriente continua, los iones adquieren una oscilacion en ese campo electrostatico. De
esta forma los iones son separados en relacion con la estabilidad de sus trayectorias en
el campo eléctrico formado. Las trayectorias seran dependientes del campo eléctrico
producido de modo que apenas los iones de una particular relaciéon m/z tendran una
trayectoria estable y llegaran al detector. Los demas valores de m/z tendran trayectorias
inestables y podrian colisionar o escapar de la regidén central del cuadrupolo, no llegando
al detector. Debido a este proceso, es comun decir que el analizador de masas
cuadrupolar es un filtro de masas.

Una de las caracteristicas mas interesantes del MSD es su capacidad para funcionar como
un detector universal, selectivo o especifico. En la actualidad, la utilizacién de mas de un
analizador en una configuracién multidimensional lo transforma en un detector especifico,
esta configuracién también es conocida como tdndem (MS/MS). Para realizar un analisis
de masas en tandem en el espacio, es necesario tener multiples analizadores conectados
en serie. Una de las configuraciones mas comunes de espectrometros de masas en
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tandem es el triple cuadrupolo (QQQ o QgQ). Los componentes basicos del GC-QgQ
consisten en una fuente de ionizacion, un cuadrupolo (Q1), una camara de colisiones
(Q2), un segundo cuadrupolo (Q3) y un detector.

Un modo de analisis mas utilizado en el QqQ es el monitoreo de reaccién multiple (MRM,
Multiple Reaction Monitoring). En este modo de adquisicion, la fuente de ionizacién
produce los iones, el Q1 es el primer filtro de masas que permite la seleccionar el ion de
interés, llamados de iones precursores (también conocidos como iones padre). En la
camara o celda de colisiones (Q2) ocurre la fragmentacién del ion precursor. Un gas de
colisién como el nitrégeno es introducido produciendo la fragmentacién del ion precursor
seleccionado generando los iones producto (conocidos como iones hijo). El Q3, actua
como un segundo cuadrupolo filtrando el paso de los iones productos seleccionado para
permitir que lleguen al detector. Note que es poco probable que haya otro compuesto
con las mismas transiciones de ion producto y ion precursor que las del analito. El QqQ
permite analizar especificamente los iones de interés, eliminando interferencias y
disminuyendo el ruido en la medicién. De esta forma se obtiene mejor sensibilidad vy
selectividad (STASHENKO & MARTINEZ, 2010).

Este instructivo describe el procedimiento para el manejo adecuado en rutina del equipo.
El equipo consta de un espectrometro de masas (MS) de triple cuadrupolo Agilent serie
7000D, cromatografo de gases (GC) Agilent GC serie 7890B, muestreador automatico de
liquidos (ALS, Automatic Liquid Sampler, por sus siglas en inglés) serie 7643 con bandeja
para 150 viales (véase Figura 1), conectados a un computador con el software para
manejo y adquisicion de datos MassHunter Workstation Version B.07.05. El equipo
también puede ser operado desde el panel de control de operaciones del GC. Dentro del
paquete del software incluye el Data Acquisition, Quantitative Analysis y Qualitative
Analysis.

Desde el software MassHunter Data Acquisition se puede: iniciar y detener el
instrumento; revisar la configuracién del equipo en tiempo real; crear, editar, ejecutar,
cargar un meétodo; crear, editar, comprobar, ejecutar una secuencia, evaluar los
parametros del MS, supervisar las condiciones en tiempo real de los parametros del
instrumento. Presione F1, use el menu Help o el botén Help en cualquier cuadro de
didlogo para acceder a Help en linea para el software MassHunter Data Acquisition.
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Figura 1. Sistema de triple cuadrupolo Agilent 7000D, con cromatografo de
gases Agilent 7890B y muestreador automatico de liquidos ALS.

ALS

Cromatoégrafo de gases
GC serie 7890B

Triple cuadrupolo MS
serie 7000D -

Panel

Interruptor de
alimentaciéon de MS

Interruptor de
alimentacion del GC ___Bandeja

Fuente. Adaptado del manual del instrumento (2024)

de operaciones

(pant‘:alla, indicadores
de estado y teclado)

El sistema cuenta con una coleccion de manuales, videos, guias de familiarizacién,
aplicaciones de usuario y herramientas de desarrollo de métodos en idioma inglés para
consultarlos en caso de dudas. Los archivos se encuentran en medios magnéticos en:

e Agilent GCy GC / MS Manuales de usuario y herramientas DVD set.

e Agilent GC / MS Software Informacidon y manuales memory stick.

También es posible ingresar desde los accesos directos disponibles en el DESKTOP del
computador (véase Figura 2).
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Figura 2. Ubicacion de los accesos directos a los manuales de usuario.
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Agilent Technologies

Fuente. Propia (2024)

6.5.2. Encendido del equipo

Antes de proceder a encender el equipo se deben verificar las condiciones basicas del
sistema para que sea puesto en funcionamiento evitando dafios o problemas.

Abra las valvulas de los cilindros de gases de helio (He) y nitrégeno (Nz), grado de pureza
5.0 (99.9995%) ubicados en el cuarto de maquinas. El He se utiliza como gas de arrastre
y el N> para la cdmara de colisiones activadas.

Revise que la presidon en los cilindros sea mayor de 500 psi. Caso la presién sea menor
se debe realizar el reemplazo por un cilindro lleno antes de que la presion llegue a 300
psi.

Nota: si se trabaja con el cilindro de He a presiones menores, se pueden introducir
contaminantes que afectan el sistema.

Llene el formato de control de uso de gases que se encuentra en el cuarto de maquinas.
Abra las valvulas de la linea de gases ubicadas en el area instrumental de cromatografia.

Verifique la presion de entrada de cada gas en el puesto de trabajo, el manédmetro debe
mantenerse a una presion de 80 psi, véase Figura 3.
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Figura 3. Lineas de gases para el cromatégrafo CG-QqQ.

Fuente. Propia (2024)

Conecte todos los equipos a la fuente de poder que se encuentra regulada por la UPS de
6 KVA, incluyendo el computador. Verifique que la UPS esté funcionando correctamente.
Las baterias deben estar full y la carga que estd consumiendo el equipo debe ser
aproximadamente del 10% de la capacidad de la UPS.

Revise el nivel de aceite de la bomba mecanica. Se debe realizar el cambio del aceite
cada 6 meses, maximo cada afio. La bomba mecanica debe estar con el botén encendido
en ON. El nivel del aceite no puede estar por debajo del limite inferior como se muestra
en la Figura 4.

Figura 4. Verificacion del nivel de aceite de la bomba mecanica.

Fuente. Propia (2024)

Encienda el computador del cromatégrafo con el botén de encendido de la CPU, luego
oprima el botdn de encendido del monitor. Espere que cargue el sistema y digite el
usuario “admin” contrasefia “3000hanover”, también puede ingresar solamente con el
usuario "ideam".
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Encienda el cromatégrafo de gases con el interruptor de alimentacion del GC que esta
localizado en la esquina inferior izquierda, debajo del compartimiento del horno
cromatografico (véase Figura 1). Automaticamente se encendera el muestreador
automatico.

Encienda el detector selectivo de masas con el interruptor de alimentacion del MS ubicado
en la esquina inferior izquierda del moédulo del detector de triple cuadrupolo (véase
Figura 1). Automaticamente, se encenderd la bomba de vacio mecanica y se escuchara
el ruido caracteristico del arranque del motor.

Ingrese al software MassHunter Workstation Version B.07.05. Haga doble clic en el icono
del "CG-QQQ" que se encuentra en el DESKTOP, como se muestra en la iError! No se
encuentra el origen de la referencia..

Figura 5. Iicono del software Mass Hunter Data Acquisition program.

1. | :

% BB

Agilent GC-QQQ OFFLINE Qualitative MS
GCMS Con... Analysis... Quantitati.. Quantitati...

AT R A

Sequence Library Editor Unknowns GCMS Agilent GC
Table A... Analysis Translator  Firmwar... ESSENTL...

il
(A 2

Parts Finder Agilent
Instrume...

Fuente. Propia (2024)

Espere unos minutos mientras abre el software y se establece la comunicacion entre el
cromatdgrafo, el detector y el software MassHunter Data Acquisition (véase Figura 6).
Puede cerrar la ventana del GC Status, los valores en tiempo real son mostrados en el
Instument Control del monitor del computador.
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Figura 6.Instrument control view del software MassHunter Data Acquisition.

Fuente. Propia (2024)

Nota: Para confirmar la comunicacién del sistema verifique la conexién oprimiendo el
botdn "Options" en el panel del GC, baja con la flecha del panel ¥hasta "Communication",
oprime "Enter". En el display del GC apareceran los parametros de COMMUNICATIONS
SETPOINTS, verifique que aparezca la direccion IP 192.168.254.11 perteneciente a la
conexidon con el cromatdgrafo y la direccién 192.168.254.12 de la conexién con el
espectrometro de masas.

Otra forma de confirmar la conexidn del sistema con el cromatodgrafo y el detector puede
ser mediante el computador, ingresando al menu Inicio >> CMD. Digite el comando PING
seguido de espacio y la direccion IP del cromatégrafo: “"PING 192.168.254.11", como se
muestra en la Figura 7. Deben aparecer cuatro mensajes con la especificacion TIL=64
al final que confirma la conexion entre los sistemas. Posteriormente, se repite el proceso
con el nimero de la direccion IP del espectrémetro de masas, ingresar “PING
192.168.254.12". En el caso en que no se compruebe la comunicacion correcta entre los
sistemas, comunicarse con servicio técnico.
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Figura 7. Verificacion de la conexion del GC y MS, comando CMD.

@ C:\Windows\system32\CMD.exe = | B |

Microsoft Windows [Uersion 6.1.76811
[Copyright {c) 2009 Microsoft Corporation. All rights reserved.

m.| »

[Cz=~\Users\IDEAM>PING 192.168.254.11

[Pinging 192.168.254.11 with 32 bytes of data:
[Reply from 192.168.254.11: hyt time{ims
[Reply from 192.168.254.11: hyt i

[Reply from 192.168.254.11: hyt

[Reply from 192.168.254.11: hyt time<ims

[Ping statistics for 192.168.254.1

Packets: Sent = 4, Recei 4, Lost = €@z loss>.
Approximate round trip times milli-seconds:

Minimum = Bms. Maximum = Bms. Average = Bms

[C:\Users\IDEAM>PING 192.168.254.12

[Pinging 192.168.254.12 with 32 hytes of data:
[Reply fFrom 192.168.254.12: hyt time<{ims
Reply from 192.168.254.12: hyt i

[Reply From 192.168.254.12: hyt

[Reply from 192.168.254.12: hyt

[Ping statistics for 192.168.

ackets: Sent = 4, Recei: Lost = €@z lossX.
Approximate round trip times il illi—seconds:

Minimum = Bms. Maximum = B Average = Bms

[Cz\Users\IDEAM>

Fuente. Propia (2024)

Para accionar el alto vacio en el espectrometro de masas se ejecuta el procedimiento de
PUMPDOWN. Desde el MassHunter Data Acquisition program ir a [Instrument] > [MS
Vacuum Control] o desde el Instrument Control View dar click en el icono del
Vacuum Control® (véase

).

Figura 8. Vacuum Control del espectrometro de masas.

°_ GC-QQQ/Enhanced MassHunter - Clorotalonil MRM 15 pruebaM/ ATUNE / 20170802 Transiciones MRM:
Method | Instrument | Sequence View Abort Window Help

Inlet/Injection Types...

B nstrum Sample Prep...
Enabl le Prep..

| Edit Mor

Method Instrument

ion.
GC Show/Hide Status

& — ROQEV L L0HES

Wake

Backflush Wizard

L] A2 Temperature Tic Rough Vac (mTorr) ce Temp. (° Collision Flow
I

Spectrum MS1 Quad Temp. (°C) ow
\ 0.928 [ 0.0 |

Pump 1 Current (4) Turbo 1 Speed (%) Ms2 Quad Temp. (*C) Filament Current (uA)

==

Fuente. Propia (2024)
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Seleccione la opcién PUMPDOWN, en seguida se abrira una ventana en la que preguntan
si le gustaria cargar las temperaturas altas de (230/150/150) de la fuente de ionizacién
y los cuadrupolos (MS1 y MS2), dar click en YES, como se muestra en la Figura 9. El

sistema demorara aproximadamente 20 minutos en alcanzar

especificados.

SS—SS——S——————————————————,.,
Triple Quadrupole Vacuum

Rough Vac

High Vac

Figura 9. Activacion alto vacio PUMPDOWN.

Pumpdown

Status
Pumpdown Cycle Started: 8/22/2017 $.08:54 Al
<Bapsed Tme:>

Actuzle Crteria

Turbo 1 Speed

Turbo 1 Power
Rough Vac

High Vac

Source Temp.

s 8 3 7

MS1 Quad Temp.

M52 Quad Temp.
163E+2  mTom

1034 Tor [
70000 US1645U003
Trple Auds Seies 2 detector

E—

Pumpdown ‘ ‘ Bakeout... ‘ l Airand Water Check. l

9:08:39 AM.

Default CheckTune limits have been restored at 8/22/2017

[ Print air and water check report

>

Abort Air and Water Check

o [ =

Fuente. Propia (2024)

B
g
B

los parametros

Select Temperature Setti

ings.

@ \ouid you like to load high temperature
B9 1 not. 10071007100 will be lozded

D) [l

==
)

settings (230/150/150)7

Verificar los parametros del espectrometro de masas, velocidad turbo (Turbo 1 Speed,
100 %), alto vacio (high vacuum, entre 1 x 10> - 5 x 107 Torr), las temperaturas de la
fuente de ionizacién (Source Temp, 230 °C) y los cuadrupolos (MS1 Quad temp, 150 °C
y MS2 Quad Temp, 150 °C), como se muestra en la
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Figura 10. Estos parametros también pueden ser observados en el INSTRUMENT
CONTROL del MassHunter Data Acquisition. Espere aproximadamente 2 horas hasta que
el espectrometro de masas alcance el equilibrio térmico.
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Figura 10. Parametros del espectrometro de masas.

Pumpdown

Status Ready

Pumpdown Cycle Started: 9/8/2017 8:09:22 AM

Bipsed Time: 22 mins 47 secs

Aetuals Cteria
Turbo 1 Speed 1000 >0 %

Turbo 1 Power %9 — W

Rough Vac 142E+2 —  mlom

High Vac 5.55E-5 —  Tor

.
Source Temp 20 — ¢
151 Quad Temp. 150 - T

C

MS2 Quad Temp. 150 —

6Ca00
70000 US 1645003 Cose £
Triple Axs Series 2 detector

i

Fuente. Propia (2024)

6.5.3. Comprobacion del Estado del Equipo

Se realiza el chequeo para verificar que el sistema no tenga agua ni aire, ademas del
ajuste del detector con el Autotune.

Air and Water Check

Para realizar la prueba de presencia de agua-aire seleccione en el Instrument Control
el icono Vacuum Control @>[Air and Water Check], seleccione la opcién de imprimir
el informe ¥ Print air and water check report. Antes de realizar la prueba le aparecera
un mensaje en donde el software le recuerda que debe apagar el flujo de gas de N> de
la celda de colisiones (Turn Off Collision Cell Nitrogen (Nz) Gas). Para esto, el flujo de N;
puede ser apagado manualmente con el botdn del panel del cromatdgrafo [Aux EPC #],
en la opcion CID Flow (N:) prosiga dando [OFF] > [Enter]. El sistema no puede
contener agua porque puede quemar el filamento. La presencia de aire indica que pueden
existir fugas y es posible que dafie la columna. Para la verificacion de la conformidad de
la prueba se deben cumplir los siguientes criterios:

H>O Relacidon 18/69 < 20 %
O Relacidon 32/69 <2.5%
N> Relacién 28/69 <10 %

Si la relacién Ny) : Oz%) > 4:1 es un indicio de que hay contaminacién, una de las
fuentes puede ser las impurezas del cilindro de gas de He que se esta acabando. Por el
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contrario, si la cantidad de oxigeno es mayor, puede ser atribuido a una posible fuga, la
cual debe ser identificada y corregida.

Al finalizar la prueba de Air and Water Check, el software muestra el informe (véase
Figura 11). Si la prueba falla en la relacién del H,O (%), se debe realizar un Bakeout
para aumentar las temperaturas de la fuente de ionizacion y los cuadrupolos y asi retirar
la humedad (véase Seccién 8.3.2). Nota: todas las fallas deben ser subsanadas antes de
realizar el ajuste del detector.

Figura 11. Informe de la prueba de Air and Water Check.

Airand Water Chack ===

PFTBA Abundance (m/z 69) 6793767.5
Water Abundance (H20, m/z 18) 10169662.0
Oxygen Abundance (02, m/z32)  23208.0
Nitrogen Abundance (N2, m/z 28)  86496.2

Ratio H20 to m/z 69 149.69%  Limit <=20.00% -
Ratio O2 to m/z 69 0.34% Limit <=2.50% OK
Ratio N2 to m/z 69 1.27% Limit <=10.00% OK
* Nitrogen values are calculated from oxygen abundance

Fuente. Propia (2024)

Bakeout

Para eliminar el agua del sistema se debe ejecutar Bakeout. Este procedimiento permite
realizar una limpieza térmica al detector aumentando las temperaturas de la fuente de
ionizacion y los cuadrupolos. Seleccione en el Instrument Control el icono Vacuum
Control 9> [Bakeout]. Se debe modificar solamente el tiempo de ejecucion, es
recomendable establecer como minimo de tiempo 1 hora. Al finalizar el Bakeout realice
nuevamente la prueba de Air and Water Check conforme esta descrito en la Seccion
3.3.1. Verifique que todos los parametros cumplen con las especificaciones, caso no sean
cumplidos los criterios de los valores de H>0 realice nuevamente el Bakeout. Si el reporte
de la prueba de Air and Water Check cumple con las especificaciones requeridas en la
Seccion 8.3.1, continuar con el Autotune (véase Seccién 8.3.3).
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Figura 12. Eliminacion de la humedad mediante el Bakeout.

Bakeout starled. waiting o reach larget temperatures.

e e Bakeout Seang Mathod Soiny At Voo b

Fetnment State j— )

| || Fies nd Reports | Aot | Advances Actunel

o4 1 Tempersturs
Ousd 2 Tempersturs

Bkeout e 1w om

U Frit o and water chack report

_ Air and Water Chock Finishod
{

Fuente. Propia (2024)

Autotune

Para realizar el ajuste del espectrémetro de masas se ejecuta el Autotune en el modo
de EI (ionizacién electrénica). Desde el MassHunter Data Acquisition program ir a

[Instrument] > [MS Tune] o desde el Instrument Control dar click en el icono del
MS Tune - (véase
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Figura 13. Acceso al Tune del MS a través del MassHunter Data Acquisition
program.

“, GC-QQQ/Enhanced MassHunter - Clorotalonil MRM 15 prueba.M / ATUNEU / 20170802 Transiciones MRM.
Method | Instrumen t | Sequence View Abort Window Help

OO OO

Method Instrument

HERV %lw@~ |

T nstrum Sample Prep... =5 =N ]

Enable Sample Prep...

Aux—z Temperature

- |:]
""""" Spectrum
onfigure MS Gases...
e
n
itchlon ent..
BN cheom Run Agilent Instrument Utilities
atograms (Normalize)

0.768

Pump 1 Current t (A)

\ 100.0 m

Turbo 1 Speed (%) Ms2 Quad Temp. (*C)

Fuente. Propia (2024)

Seleccionar la pestafia de [Autotune]>[Autotune], en el Autotune type dar click en
® EI high sensitivity autotune, en el Autotune Options dar click en ¥ Print autotune
report, Save tune file when done y dar click en ®Default name. Para ejecutar, dar
click en el botdn de Autotune localizado en el esquina inferior derecha (véase Figura
14). Esperar hasta que termine el proceso. Cuando el ajuste haya finalizado, aparecera
una ventana de aviso con el mensaje de Autotune done, dar click en OK. El archivo con
el informe del Autotune quedara guardado en D:\MassHunter\GCMS\1\7000\Tune
Reports. Seleccione la carpeta del Autotune con la fecha en la que fue realizada el ajuste,
el archivo atunes.eiex.tune.xml debe ser cargado en el método de adquisicién que se
va a utilizar. Dentro de la carpeta también encontrara el archivo de informe guardado
como TuneReport.
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Figura 14. Ejecucion del ajuste del MS a través del Autotune.

Triple Quadrupole MS Tune - stunes. siextunesml - -
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zss (mz] v
al Vaive

Files and Reporte| Autotune | Advanced Autotune | Manual Tune [ Vacuum Control
(Adtolune [ Theck Tune| Emission cur ment 238

Autotune Type

Stabilization delay 19

El autotune

0T

1650°C

150°C

N/A

On

350uA

seconds

Ovenide stabiization delay l l
PCl autotune

g

el

)

NClautotune

Autotune Options

[] Tune from defauk settings

[F] Use custom autotune parameters

[T Print autotune report
V] Save tune file when done.

® Default flename.

*) Cument fiename

Dar click para

iniciar

el ajuste

Save as I Browse

_ Default CheckTune limits have been restored at 8/8/2017 2:20:50 PM. l

Fuente. Propia (2024)

Después ejecute el Check tune para verificar que todos los parametros son satisfactorios
para operar el equipo. En la pestafia del [Autotune], seleccione [Check Tune]. En la
esquina inferior derecha dar click en Print Check Tune Report y en seguida para
ejecutar el chequeo dar click en la opcién Check Tune (véase Figura 15). Al finalizar
evalle el informe del Check Tune (véase Figura 16). Verifique que todos los parametros
estén conformes con los valores y limites permitidos por el fabricante, el resultado debe
ser OK en todos los parametros para aceptar la conformidad del equipo para su uso. Un
aumento en el valor del voltaje del electromultiplicador (EMV>2500), puede ser un
indicativo de contaminacién en la fuente de ionizacién.
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Figura 15. Check tune del ajuste el MS de triple cuadrupolo.

—
le MS Tune - atunes.iex.tunexml

Triple Quad
Mass (miz) 218.00 counts 27356200.0
x107. 218.00
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40 60 80 100 120 140 160 180 200 220 240 260 280 300 320 " JAD[ ‘Z]JSD 380 400 420 440 460 480 500 520 540 560 580 600 620 640
sss (m
Files and Reports | Autotune | Advanced Autotune | Manual Tune | Vacuum Control
Check Tune Settings Air and Water Leak Check
Mass assignment <= 020 amufrom taraet mass
Fato of waterto low mass <= 20 %
Lowmass iscope >= 05 adc- 16 % oftarget mass abundance
Rato of ntragen tolow mass <= 00 %
Mid mass isctope >= 42 and<= 69 % of target mass abundance
High mass isctope > 75 and = 123 % ofterget mass abundance E——
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e iniciar el chequeo
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Default Check Tune limits have been restored at 8/8/2017 223:17 FM [] Print Check Tune report

| Abort Tune
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Fuente. Propia (2024)

Figura 16. Resultados de la evaluacion del autotune a través del Check Tune.

Triple Quadupcle MS Tune - stunes cvextune omd

B3 w07
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Fuente. Propia (2024)
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6.5.4. Apagado del equipo o venteo
Para proceder apagar el equipo, se puede bajar manualmente las temperaturas del GC.
Desde el panel de control apagar la temperatura del inyector (oprimir tecla [Front Inlet]
> [Off]> [Enter]), el horno (Oven > [30 °C] > [Enter]) y la interface ([Aux Temp
#] > [Off]> [Enter]).

Realizar el venteo desde el software MassHunter Data Acquisition program, ejecute
[Instrument]>[MS Vacuum Control] o desde el Instrument Control dar click en el
icono del Vacuum Control® . Dar click en

[Vent] para comenzar el ciclo de venteo. El procedimiento de venteo incluye el
enfriamiento de las zonas de alta temperatura del equipo antes de perder el alto vacio
del espectrometro de masas. Un cuadro de didlogo con el estado del sistema muestra los
cambios en progreso del ciclo de venteo (véase Figura 17).

Figura 17. Ciclo de venteo para apagar el equipo.

Status Venting

Vent Cycle Started: 9/14/2017 10:25:16 AM

Eiapsed Time: 6 mins 50 secs

Turbo 1 142 0.1 Actuals Criteria

Turbo 1 Speed 142

Rough Vac 87441 mTor
Turbo 1 Power 01 - w

High Vac Off Tor
Rough Vac 874E+1 —  mTor

High Vac off -

‘ Vent Pumpdown } Bakeout ‘ \ ‘
| { L J | Source Temp. 152 <100

MS1 Quad Temp. 128 <100

g ad d g
g

‘ MS2Quad Temp 128 <100

6caqa - - ZL
70000 US16450003
Triple Auds Series 2 detector e ‘ I

Default CheckTune limits have been restored at 9/14/2017 r
10:25:13 AM.

Fuente. Propia (2024)

Espere hasta que aparezca en la pantalla el mensaje de Vent "READY" y verifique que el
horno y la interface estén a temperatura ambiente antes de cerrar el flujo del gas de
arrastre. Si se permite que entre aire al sistema y las superficies estan calientes, el
oxigeno podria generar danos en estas partes del equipo.

Nota: en caso de ser estrictamente necesario el apagado rapido debido a fallas de energia
eléctrica, entre otros, el equipo puede ser apagado cuando la velocidad de la turbo (Turbo
1 Speed, %) alcance aproximadamente el 20%.
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Cierre la ventana del software MassHunter Data Acquisition program y apague el
computador.

Apague el cromatdgrafo de gases con el interruptor de alimentacion del GC que esta
localizado en la esquina inferior izquierda, debajo del compartimiento del horno
cromatografico.

Apague el detector selectivo de masas con el interruptor de alimentacion del MS ubicado
en la esquina inferior izquierda del mddulo del detector de triple cuadrupolo.

Desconecte los equipos de la fuente eléctrica.
Cierre las llaves del flujo de gas de helio y nitrégeno.
6.5.5. Configuracion de los parametros del GC

Editar los parametros de configuracién del cromatdgrafo de gases. Ingrese desde el
Instrument control MassHunter Data Acquisition program al menu Instrument >GC
Parameters. En el panel izquierdo dar click en Configuration, también se puede
ingresar desde el icono del GC Parameters como se muestra en la Figura 18. Se deben
establecer las condiciones de los opciones de Miscellaneous, Columns, Modules y
ALS.

Figura 18. Parametros de configuracion del GC.

“_ OFF LINE/Enhanced MassHunter - DEFAULT.M tunexml / default.sequence: [E=Srad ]

Method | Instrument | Sequence View Abort Window Help

Inlet/Injection Types...

-
i intrug,___Edit Monitors.. GC Parameters

GC Parameters...
Run Iple Name:

- <c ot | _ ;
cccotpmin. 10.00 &
Instry i on 3 File: - V

GC Show/Hide Status Run Time

Backflush Wizard

Method
MS Parameters..

Conl fgu e MS Gases...
MS Show/Hide Status Aux-2 Temperatut Column-1 Flow Calc. Collision Flow

= | — I

Filament Current (uA) MS1 Quad Temp. (°C) Spectrum High Vac (Torr) ‘ Rough Vac (mTorr) Quench Flow

‘ Source Temp. (*C)

Fuente. Propia (2024)
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En la opcidn Miscellaneous del panel de control izquierdo seleccionar las unidades de
presion, para esto seleccione en el campo Pressure Units la opcidén psi (véase Figura

19).

Figura 19. Configuracion de las unidades de trabajo para la presion del GC.
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Fuente. Propia (2024)

Registrar la columna cromatogréfica. Ingrese al Instrument >GC Parameters. En el
panel izquierdo dar click en Configuration > Columns. Inicialmente se debe realizar la
instalacién en el software de la columna que se va a utilizar en el GC y calibrarla para
mantener éptimas condiciones del flujo en la columna. Todas las columnas de Agilent-
J&W estan disponibles en el catdlogo guardado dentro del software. Para esto debe dar
click en el nUmero de la columna que se va a adicionar, después se abrird el cuadro de
Edit Properties of Installed GC Column. Seleccionar la columna desde el catalogo, si
por el contrario la columna no es de marca Agilent, se pueden registrar todos los datos
de la columna de acuerdo con el fabricante. Para adicionar la columna desde el catalogo,
dar click en el boton Select from Catalog (véase Figura 20).
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Figura 20. Configuracion de la columna.
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Fuente. Propia (2024)

Seleccionar la columna de acuerdo con el Part Number y dar click en Install (véase
Figura 21).

Figura 21. Seleccion de la columna cromatografica desde el catalogo.

Sl GC Column Catalog [l=lE| =]
Inventory.. Creste Layout Update
- Find Clear [ Orily Show Calumns Added To Invertory

PartNumber  Ma... - Description Fav... | en- D'j;{ - _I.';'i';"v ':‘I:;: Ten:";: w 're:g}.{ - .’:_":;:“3,(9:' gorm  Keyw.. Comments | Time Stamp

13 190915-433 i Agilent HP-5ms ‘/ 30 250 0.25 250 -60 325 350 F-inch HP-5ms 05/20/15 ...
190915-413 Agilent HP-5ms 30 320 0.25 320 -60 325 350 74nch HP-5ms 05/20/15 ...
190915-433E  Agilent HP-5ms 30 250 0.25 250 -60 350 350 S-inch HP-5ms 05/20/15 ...
190915-416 Agilent HP-5ms 60 320 0.25 320 -60 325 350 F4nch HP-5ms 05/20/15 ...
190915-436 Agilent HP-5ms &0 250 0.25 250 -60 325 350 F-inch HP-5ms 05/20/15 ...
190915-577 Agilent HP-5ms 20 180 0.18 250 -60 325 350 F-nch HP-5... 05/20/15 ...
190915-577E  Agilent HP-5ms 20 180 0.18 250 -60 325 350 S-inch No Lo... 05/20/15 ...
190915-57... Agilent HP-5ms 20 180 0.18 250 -60 325 350 LTM HP-5... 05/20/15 ...
1505915-10... Agilent  HP-5ms 12 =0 033 152 0 325 350 LTM HP-5... 05/20/15 ...
190915-10... Agilent HP-5ms 25 200 0.33 152 -60 325 350 LTM HP-5... 05/20/15 ...
150515-13... Agient HP-5ms 3 20 0.5 125 0 325 350 LTM NoLe... 05/20/15 ...
190915-23... Agilent HP-5ms 15 250 1 63 -60 325 350 LTM No Lo... 05/20/15 ...
150515-23... Agient  HP-5ms 3 2% 1 63 <0 325 350 LTM NoLa... 05/20/15 ...
19091S5-33... Agilent HP-5ms 15 250 0.1 625 -60 325 350 LTM HP-5... 05/20/15 ...
150515-33... Agient HP-5ms 3 20 0.1 825 <0 325 350 LTM NoLa... 05/20/15 ...
190915-43... Agilent HP-5ms 15 250 0.25 250 -60 325 350 LTM HP-5... 05/20/15 ...
190915-43... Agilent HP-5ms 30 250 0.25 250 -60 325 350 LTM HP-5... 05/20/15 ...
19091S8-11... Agilent HP-5ms 25 320 0.52 154 -60 325 350 LTM No Lo... 05/20/15 ...
190915-11... Agilent HP-5ms 30 320 0.5 1s0 -60 325 350 LTM Mo Lo... 05/20/15 ...
190915-21... Agilent HP-5ms 30 320 1 80 -60 325 350 LTM No Lo... 05/20/15 ...
190915-31... Agilent HP-5ms 30 320 0.1 800 -60 325 350 LTM Mo Lo... 05/20/15 ...
190915-41... Agilent HP-5ms 30 320 0.25 320 -60 325 350 LTM HP-5... 05/20/15 ...
122-4532 Agilent DB-5ms 30 250 0.25 250 -60 325 350 Mo Lo... 05/20/15 ...
CP7419 Agilent Select FAME 50 250 o -59 275 290 7-inch Select.. 05/20/15 ... -

I «ﬁ:ﬁ_;ﬁzlgz.{42—33‘ }. ’: ;N .:-.‘.7( x - T - - o T ' . ST
Print... [ msmn | [ pome | [ ke

Fuente. Propia (2024)
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Después dar click en el botén Create Inventory, se abrira el recuadro del Column
inventory. Proceda a registrar el nUmero del serial de la columna en el campo del
Inventory Number seguido de OK. El software llevara el inventario de las diferentes
columnas que se utilicen de acuerdo con el serial que se registre, asi se podra llevar la
trazabilidad cada vez que se cambia por una columna nueva con las mismas
especificaciones. Posteriormente, seleccionar las partes de entrada y salida en la que
estara conectada la columna dentro del cromatdografo. En este caso en el campo del
Inlet debera seleccionar Front Inlet y en el campo del Outlet seleccionar MSD. En el
campo Heated By seleccionar Oven conforme se muestra en la Figura 22.

Figura 22. Registro de la columna cromatografica en el inventario del software.

-

Column Inventory R
r N
GC Column Catalog Enter Barcode Data...
9 Cument Selection (122-5536LTM) is a Non4inventoried £ort embes
" / Catalog ftem. 122-5536
' i Numb
Do you Want to Use this Selection without Adding it to Your nventory Number
Inventory
or S
Create an Inventory ftem Whose Maintenance Counters GC Serial Number
can be Tracked? CN10703004
Position in GC
Use This ] [Create Inventory... J [ Cancel J 2
\ A
[ ok | | Ccancel
\ A
Column Calibration Resul Inlet Outlet Heated By
Agilent 190915-433: 12345 e t — |L = - |

HP-5MS 5% Phenyl Methyl Silox Uncalibrated
\l/ -60 *C—325*C (325 *C): 30 m x 250 pm x 0.25 pm

[ _
I

Mo Column Installed Uncalibrated

Mo Column Installed Uncalibrated [Unspe{iﬁed * | Other - |Oven -
No Column Installed Uncalibrated [Unspe{iﬁed ¥ | Other - |Oven -
[I] No Column Installed Uncalibrated [Unspe{iﬁed ¥ | Other - |Oven -

4

Back Detector

~ |Qven -

Fuente. Propia (2024)

Nota: si la columna registrada en el software no se va a utilizar inmediatamente en el
equipo, se recomienda establecer el campo del Inlet de la tabla como Unspecified para
evitar que genere errores en el calculo de las presiones y flujos del sistema.
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Calibracion de la columna. Es importante realizar la calibracion de la columna para que
el equipo pueda realizar una estimacion real de las dimensiones y calcule correctamente
los flujos y presiones durante la corrida cromatografica. El procedimiento para realizar la
calibracidn en el software es el siguiente: desde el menu o desde la parte grafica dar click
Instrument >GC Parameters. En el panel izquierdo dar click en Configuration >
Columns > Calibrate > Calc Length. Registrar el tiempo de muerto determinado a
partir de la inyeccion de una sustancia no retenida en la columna en el campo del Holdup
time of an Unretained Peak, en seguida dar click afuera del dato registrado para
verificar que se hayan realizado los ajustes. Verificar los datos de los demas parametros
(temperature, inlet and outlet pressures, y gas type) utilizados para determinar el
Holdup Time. Actualice cualquier pardmetro que sea diferente al utilizado en el método
de adquisicidn. Finalmente dar click en Ok (véase Figura 23).

Figura 23. Calibracion de la columna cromatografica.
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» ength
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Holdup

Current
30m
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30m

250 pm
20125 min

l oK l | Cancel

Fuente. Propia (2024)

Al finalizar el proceso, verificar que en las especificaciones de la columna en la tabla del
menu Column aparezca en el item de Calibration result la fecha de calibracién. De
esta forma, se confirmard que se hayan guardado los cambios de la calibracion.

Es posible determinar el tiempo muerto inyectando aire, se verifica el tiempo de elucién
de los iones de N2 y CO, (m/z 28 y 32, respectivamente), a través del cromatograma de
ion extraido desde el software Qualitative MassHunter (véase Seccién 8.9.6).
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Desde la configuracién del GC seleccione los gases para los diferentes modulos. Ingrese
a Instrument >GC Parameters. En el panel izquierdo dar click en
Configuration>Modules. Desde la opcién Front Inlet en el campo de SS Inlet
seleccionar el helio: He. Para la opcién Collision Cell/Backflush en el campo Quench
Gas, automaticamente establece el He porque es el gas de arrastre. En el campo de
Collision Gas seleccione el nitréogeno: N, finalmente para el Backflush Gas seleccione
el helio: He (véase Figura 24).

Figura 24. Configuracion de los gases en los mdodulos del GC-QQQ.

62 GC Edit Parameters — o e o I ———

300
250
200
150
100
S0
o

°C

[} 1 2 3 4 S 6 7 = 9 10

|
Select... Front Inlet
~ % ALS ssiniet [He -
c .
Tront 'gJiCtor Collision Cell/Backflush
ray/ ther Quench Gas He
4 Inlets
¥4 columns Collision Gas {NZ vl
e
\L' Oven Backflush Gas {He =
& Aux Heaters —_—
) Events

li_ Signals
~ ¥ Configuration
Miscellaneous
Columns
3 Modules
ALS
&l Backflush
il Readiness
# GC Calculators

Fuente. Propia (2024)

Configuracion ALS. Desde la configuracion del GC seleccione los parametros para el
automuestreador ALS. Ingrese Instrument >GC Parameters. En el panel izquierdo dar
click en Configuration > ALS. Ingrese tamafo de la jeringa, para esto en Syringe Size
establezca 10 HL. En el modo de lavado de solvente, se utilizaran solo los frascos A y B.
Entonces en Solvent Wash Mode, seleccione A, B (véase Figura 25).
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Figura 25. Configuracion del muestreador automatico para liquidos ALS.
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@ A B
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Fuente. Propia (2024)

Creacion de un método

Inicialmente para la creacidn de un nuevo método puede ser generado a partir de
modificaciones del método de Default. Dar click en [Method] > [Load Method] y
seleccione Default.m (véase Figura 26). El Default es un método vacio solamente con
los requerimientos minimos como presion del gas de colisidn, caracteristicas de la
columna instalada, entre otros. Por tanto, se deben modificar los pardmetros deseados

a partir de este archivo.
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Figura 26. Creacion de un nuevo método a partir del archivo de default.
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Fuente. Propia (2024)

Guarde el método con un nuevo nombre. Dar click en [Method] > [Save Method As].
Seleccionar la carpeta donde quedara guardado el método (Method Path) y el nombre
del método (Method File), conforme se muestra en la Figura 27Figura 27. Nota:
guardar los métodos en la D:\MassHunter\GCMS\1\methods.

Figura 27. Ruta para guardar el método.
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Fuente. Propia (2024)

Seleccionar el tipo de inyector y fuente de la inyeccidén. Dar click en [Instrument] >
[Inlet/Injection Types]. En la entrada de la muestra (Sample Inlet) seleccionar GC.
En la fuente de inyeccién (Injection Source) se debe seleccionar el muestreador
automatico para liqguidos (GC ALS). Como se esta trabajando con detector selectivo de
masas, seleccione en la caja de didlogo ¥ Use MS. En la localizacién del inyector,
seleccionar Front y la conexion del MS (MS Connected to) seleccionar Front (véase
Figura 28).

Figura 28. Establecer los parametros del inyector Inlet/Injection Type

Seleccionar el inyector
N
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SEFEE§EE
o - = 4
= Y g
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@ Fromt Rear

o] [

Run Agilent Instrument Utilities Hll

Fuente. Propia (2024)

Seleccionar parametros del automuestreador. Ingrese desde el menu Instrument >GC
Parameters después seleccione en el panel izquierdo ALS > Front injector (véase
Figura 29).

En el campo de Injection, |la Syringe Size muestra automaticamente el tamano de la
jeringa establecido anteriormente desde la configuracién del GC. Seleccione el volumen
de inyeccién en el campo Injection Volume, puede seleccionar un volumen desde 1 L.
Tenga en cuenta la capacidad del liner para establecer el volumen de inyeccion.

En el campo de Washes and Pumps ingresas los datos.

e Enlaopcién Solvent A Washes ingrese el nUmero de veces que desea que la jeringa
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sea lavada antes de la inyeccion en el campo de Preinj y después de la inyeccién en
el campo PostInj con el Solvente A. Se recomienda que el volumen de lavado sea
el maximo de la capacidad de la jeringa, es decir, establezca en el campo del Volume
(HL) la opcién Max.

En la opcion Solvent B Washes ingrese el nUmero de veces que desea que la jeringa
sea lavada antes de la inyeccién en el campo de Preinj y después de la inyeccién en
el campo PostInj con el solvente B. Se recomienda que el volumen de lavado sea el
maximo de la capacidad de la jeringa, es decir, establezca en el campo del Volume
(HuL) la opcién Max.

En la opcién Sample Washes ingrese el niumero de veces que desea que la jeringa
tome una alicuota de la muestra y en el campo Volume (uL) el volumen que debe
tomar. Se recomienda que sea el mismo volumen de inyeccidn. Tenga en cuenta que
en este proceso la muestra tomada sera descartada en el vial de residuos de la torre
de inyeccion.

En la opcidn Sample Pumps ingrese el niumero de veces que dese que la jeringa
realice la purga con la muestra antes de la inyeccion.

demas opciones proveen capacidades adicionales para muestras viscosas y grandes

volumenes de inyeccién. Para una visualizacion de la opcidén en el Front injector, véase
Figura 29.

Figura 29. Parametros del automuestreador, torre de inyeccion.
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Fuente. Propia (2024)

Llairgap: 0.2l

0 pl

opL

02 pL

Calculo del volumen de vaporizacién del solvente. Antes de realizar la inyeccién, debe
asegurarse que el volumen de solvente inyectado es compatible con la capacidad del
liner que se va a utilizar. Agilent tiene una herramienta que ayuda a determinar esta
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condicion. Ingrese desde el menu Instrument >GC Parameters, después seleccione
en el panel izquierdo GC Calculators > Vapor volume calculator. El software calcula
el volumen aproximado de vaporizacion del solvente de acuerdo con la cantidad
inyectada, tipo de liner, temperatura del puerto de inyeccidon y presion en el inyector,
esta Ultima es muy importante en el caso que se trabaje con inyeccion pulsada. De esta
forma se puede verificar que el volumen inyectado no sobrepasa la capacidad del liner
y que se realizara la transferencia cuantitativa a la columna, evitando que se genere
contaminacién en el puerto de inyeccién, véase Figura 30.

Figura 30. Calculo del volumen de vaporizacion del solvente.

e alculators with method setpoints from

i

& iniet1 5 Vapor Volume Caiculator

431 pl

£ty Acetate -

add Remove | | Defauits

Soivent Vent Calculator 5190-3983 Spitess, dowbie v

Fuente. Propia (2024)

Desde el Instrument >GC Parameters seleccione en el panel navegacion izquierdo
ALS > Tray/Other. En el campo ALS Errors, escoger la opcién Pause for user
interation (véase Figura 31).

Figura 31. Parametros del automuestreador, bandeja Tray/Other.
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Fuente. Propia (2024)
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En el menu del panel de navegacion seleccionar Inlets, como se muestra en la

Figura 32.

e En el campo Split-Splitless Inlet, de click en el boton Select liner, si el liner es

de marca Agilent, seleccione el tipo de liner desde el catalogo.

e Active las opciones del Heater, Pressure y Septum Purge Flow dando click en la
caja de didlogo. Ingrese los valores de acuerdo de los parametros deseados.
e En el campo Septum Purge Flow Mode puede seleccionar la opcidon Switched.

e En el campo de Mode, puede seleccionar la inyeccién de tipo Split, Splitless,
Pulsed Split, Pulsed Splitless y Sleep. Recuerde que de acuerdo con el tipo de
inyeccién debe establecer los valores del Split Ratio, Split Flow (mL/min), o de
la presidn del pulso en el campo de Injection Pulse Pressure (psi).

e Serecomienda activar el Gas saver cuando el Total Flow sea mayor de 15 mL/min
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Figura 32. Parametros del puerto de inyeccion.
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Fuente. Propia (2024)

En el menu del panel de navegacion seleccionar Columns, como se muestra en la Figura
33. En el campo Selection se debe escoger la columna que se va a utilizar. En el campo
Control Mode, seleccionar la caja de On. Introducir los datos relacionados con el Flow,
Pressure, Average Velocity y Holdup Time. En este caso se va a trabajar a flujo
constante para que el equipo realice el control de las presiones y mantenga el flujo. Para
esto seleccione Constant Flow. Establezca el flujo de trabajo para el Post Run.
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Figura 33. Parametros de la columna cromatografica y control de presiones y
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Fuente. Propia (2024)

PostRun: 12 mL/min

BTGmn F1 CONMEUraton.
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Calibrate Column... } 1 Lock Column...

Parametros del horno cromatografico. En el menu del panel de navegacion izquierdo
seleccionar Oven, dar click en la caja del Oven Temp On e introducir la temperatura de
inicio de la corrida cromatografica. El campo de Equilibration Time (min), se refiere al
tiempo utilizado para estabilizar el equipo después que ha alcanzado las condiciones de
flujo y temperatura para iniciar una nueva corrida. En el campo Maximum Oven
Temperature, establecer la temperatura maxima que puede alcanzar el horno de
acuerdo con la temperatura maxima permitida por la columna. Configurar la rampa de
temperatura del horno. Si desea puede activar el Post Run introduciendo la temperatura
a la que llegaria el horno después de finalizar la corrida cromatografica y el tiempo que
dura en el campo del Post Run Time (véase Figura 34).

Figura 34. Programa de temperatura del horno cromatografico.

Fuente. Propia (2024)
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Parametros de la linea de transferencia. Como se estd trabajando con el detector
selectivo de masas, se debe establecer la temperatura de la linea de transferencia del
acople del GC al MSD. En el menu del panel de navegacién izquierdo seleccionar el icono
del Aux Heaters. En el campo del Thermal Aux 2 (MSD Transfer Line), activar el
calentamiento dando click en On y establecer la temperatura en °C como se muestra en
la Figura 35. La temperatura de la linea de transferencia o interface debe ser lo
suficientemente alta para mantener la muestra vaporizada, pero no puede superar la
temperatura maxima permitida para la columna. Al finalizar guarde los cambios en
Method > Save. Luego proceda a establecer los parametros de adquisicion del
espectrometro de masas.

Figura 35. Parametros de la linea de transferencia.
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~ %, ALS
Front Injector
Tray / Other
4 Inlets
¥4 columns

Thermal Aux 2 (MSD Transfer Line)

V| On

300 °C

If! oven
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43 Events

li. Signals

+ ¥ Configuration

Miscellaneous
Columns
Modules
ALS

& Backflush

il Readiness

[# GC calculators

Fuente. Propia (2024)

6.5.7. Configuracion del detector selectivo de masas de triple cuadrupolo.

El equipo del Laboratorio de Calidad ambiental del IDEAM es un cromatdgrafo de gases
acoplado al detector selectivo de masas tandem en el espacio con analizador de triple
cuadrupolo, es decir, tres cuadrupolos acoplados en serie. Uno de los cuadrupolos actua
como una camara de colisiones. De acuerdo con la configuracién del detector de triple
cuadrupolo, el equipo puede operar en diferentes modos de monitoreo, a saber: barrido
completo (Full Scan), monitoreo de iones seleccionados (SIM, selected Ion Monitoring),
barrido de ion producto (Product Ion Scan), barrido de ion precursor (Precursor Ion
Scan), barrido de fragmento neutro (Neutral Loss Ion Scan), monitoreo de reacciones
multiplas (MRM, Multiple reaction monitoring) y dinamic MRM.
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El procedimiento para establecer los parametros del espectrometro de masas MS es el
siguiente:

Desde el GC-QQQ MassHunter Acquisition software vaya al menu Instrument > MS

Parameters o desde el icono como muestra la iError! No se encuentra el origen
de la referencia..

Method

Figura 36. Ruta de acceso para el MS parameters.
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Fuente. Propia (2024)

En el campo de Method > Acquisition.
Registre las informaciones del MS Parameters, véase
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Figura 37 .
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Figura 37. Parametros del método en el detector de triple cuadrupolo
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Fuente. Propia (2024)

En el campo de Tune File, seleccione el archivo del ultimo Autotune realizado.

En el campo de Source Parameters, la Ion Source esta preestablecida como EI
(es decir, Electron Ionization o ionizacién electrénica). La temperatura de la
fuente o Source Temperature (°C) puede establecerse en 230 °C. Electron
Energy Mode, seleccione Use Tune Setting y la energia de ionizaciéon o Electron
Energy (eV) estad predeterminada como 70 eV.

En el campo de Detector Setting se recomienda trabajar con el factor de
ganancia. Seleccione Use Gain Factor.

En el campo de Run Time se recomienda establecer el tiempo del Solvent Delay
(min) para que el filamento del MS esté apagado mientras eluya el solvente.
Recuerde que demasiada humedad puede quemar el filamento. Ingresar el tiempo
de la corrida cromatografia en que se va encender el filamento.

En el campo de Time Filter activar dando On y activar las casillas del
Automatically Substract Baseline y Advance MRM/SIM Filtering.

A continuacién se explicara las opciones para ajustar algunos de los modos de adquisicion
del MS en el campo de Time Segments.

Entre los experimentos que se pueden realizar esta el Full Scan (barrido completo), este
tipo de monitoreo es equivalente al que se realiza en un equipo con cuadrupolo Unico, es
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decir, la cdmara de colisiones Q2 no esta activada. El triple cuadrupolo QQQ Agilent
7000D, permite realizar este tipo de scan en cualquiera de los dos cuadrupolos (Q1 o
Q3). En el software se puede identificar como MS1 Scan o MS2 Scan. En este caso es
recomendable que el primer cuadrupolo Q1 (analizador de masas MS1) y la camara de
colisiones Q2, estén operando en el modo de transmisién de iones o Total Transmision
Ion (TTI), permitiendo el paso de todos los iones al segundo cuadrupolo Q3 (analizador
de masas MS2) que trabajara como un filtro de masas y por ultimo los iones llegan al
detector. Con las corrientes idnicas totales se construye el espectro de masas.
Preferiblemente se debe trabajar en el modo MS2 Scan, dado que el cuadrupolo estd mas
cerca al detector.

En la
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Figura 38 se muestra un ejemplo para la seleccion del modo de monitoreo del tipo Scan.

En el campo de Scan Type seleccionar MS2 Scan.

En el campo Gain establecer el valor de la ganancia, puede estar en el rango entre
1-10.

Dar click en la casilla del Data Saved.

En la region superior derecha del display, en Scan Segments establecer el rango
de masas en el que se va trabajar. Para esto en la opcién del MS2 Start Mass
establecer el valor de 45 (m/z). En la opcion MS2 End Mass ingresar el valor de
500 (m/z), si desea analizar masas mayores puede aumentar el rango. En la
opcidn del Scan Time se debe ingresar un valor en el cual el nUmero de Data
samples sea aproximadamente 3.

En la regién inferior derecha del display, en Scan parameters en el campo de
Step size (amu) seleccionar 0,1. El valor del Threshold puede establecerse entre
50 o0 100.

Finalmente dar click en OK y guardar los cambios en Methods > Save.
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Figura 38. Parametros para operar el MS en el modo MS2 Scan.

rupole MS Method Editor — ) )

Tune File Scan Segments

Source Parameters Time Filter

Scan Parameters

Fuente. Propia (2024)

En el monitoreo de ion (es) seleccionado (s), SIM, se programa uno de los cuadrupolos
para que deje pasar solo los iones tipicos y especificos del analito que fueron previamente

sele
corr

ccionados. Los otros dos cuadrupolos trabajan en el modo TTI. Con base en las
ientes idnicas parciales obtenidas se construye el fragmentograma de masas. El

equipo permite trabajar en el modo SIM en cualquiera de los dos cuadrupolos (MS1 SIM
y MS2 SIM). Como en el caso anterior, se recomienda trabajar en el modo MS2 SIM.

En la Figura 39 se muestra un ejemplo para la configuracion del modo de SIM.

En el campo de Scan Type seleccionar MS2 SIM.

En el campo de Time (min), ingresar el tiempo de retencién del compuesto de
interés que puede ser determinado a través de la adquisicion por Scan. Pueden
ingresarse varios segmentos o ventanas de monitoreo, es decir, el tiempo de
retencion para la adquisicién de varios analitos.

En el campo Gain establecer el valor de la ganancia, puede estar en el rango entre
1-10.

Dar click en la casilla del Data Saved.

En la regidn superior derecha del display, Scan Segments ingresar el nUmero de
filas de acuerdo con la cantidad de iones que se van a monitorear en ese segmento
a través de los iconos === . Ingrese el nombre del compuesto que va a monitorear.
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En el campo de MS2 mass, ingrese la masa de los iones que desea monitorear. En
el campo de MS2 resolution seleccione la resolucién Wide (1,2 uma) y como Dwell
time (min) ingrese un valor de 50.

En la regién inferior derecha del display se muestra la opcion de Full Scan

parameters, si desea puede habilitar la adquisicién simultdanea de SIM y Scan, dando
click en la casilla Enable.

Finalmente dar click en OK y guarde los cambios en Methods > Save.

Figura 39. Parametros para operar el MS en el modo MS2 SIM.

Time Segments

Full Scan Parameters

Fuente. Propia (2024)

Barrido de ion producto (Product Ion Scan), el ion precursor o ion padre se seleccidon en
el Q1 (MS1) y se transfiere al Q2 (cdmara de colisiones activadas), donde interactia con
el gas de colision, y el gas ionizado de He, promoviendo la fragmentacion del ion para
generar los iones productos o iones hijos. Los fragmentos son entonces escaneados en
el Q3 (MS2). Esto da como resultado un fragmentograma tipico de un anélisis tandem
MS/MS. El monitoreo de iones producto sirve como un paso util en el desarrollo del
método MRM o en el caso donde se intenta elucidar la estructura de un ion precursor.

En la Figura 40 se muestra un ejemplo para la seleccion del modo de ion producto.

En el campo de Scan Type seleccionar Product Ion.
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En el campo de Time (min), ingresar el tiempo de retencién del compuesto de
interés que puede ser determinado a través de la adquisicidon por Scan. Pueden
ingresarse varios segmentos o ventanas de monitoreo, es decir, el tiempo de
retencidn para la adquisicidon de varios analitos.

En el campo Gain establecer el valor de la ganancia, puede estar en el rango entre
1-10.

Dar click en la casilla del Data Saved.

En la regién superior derecha del display, Scan Segments ingresar el niumero de
filas de acuerdo con la cantidad de iones que se van a monitorear en ese segmento
a través de los iconos === . En el campo Segment Name ingrese el nombre del
compuesto que va a monitorear. En el campo de Precursor Ion, ingrese la masa de
los iones que desea escanear el Producto Ion. En el campo de MS1 Resolution
seleccione la resoluciéon Wide (1,2 uma). En el campo MS2 Start Mass ingrese un
valor de masa menor para que empiece a hacer el barrido. En el campo MS2 End
Mass ingrese un valor masa mayor al del ion precursor. En la opcidon del Scan Time
se debe ingresar un valor en el cual el nimero de Data samples sea
aproximadamente 3. En el campo CE (eV) ingrese la energia de colisidon para realizar
la fragmentacion en la camara de colisiones.

En la region inferior derecha del display se muestra la opcion de Scan parameters,
en el campo de Step size (amu) seleccionar 0,1. El valor del Threshold puede
establecerse entre 50 o 100.

Finalmente de click en OK y guarde los cambios en Methods > Save.

Figura 40. Parametros para operar el MS en el modo de monitoreo de barrido

de ion producto.

Scan Segments

Scan Parameters

Fuente. Propia (2024)
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Monitoreo de reacciones multiples (MRM, Multiple reaction monitoring). MRM es conocido
como la herramienta final de analisis de compuestos que no produce un espectro
completo. Puede producir resultados muy especificos y sensibles. En este modo de
adquisicién es seleccionado un ion precursor del analito en el Q1 (MS1), el ion es
fragmentado en el Q2 (cdmara de colisiones) y entonces se selecciona un ion proveniente
de la fragmentacion, es decir, ion producto de la transicién o reaccién de disociacién para
ser filtrado en el Q3 (MS2). Ambos analizadores, MS1 y MS2, operan en modo SIM. De
este modo, solo los iones producto generados por la fragmentacion del ion precursor
pasado a través de Q1 son detectados.

El monitoreo de la reaccién del ion precursor e ion producto, permite confirmar la
presencia del analito en mezclas complejas. Asi, la identificacion de dos transiciones
independientes, ademas de la equivalencia del tiempo de retencidon cromatografico con
la de un patron certificado, confirma la identificacidén inequivoca del analito.

En la Figura 41 se muestra un ejemplo para la seleccién del modo de MRM.

e En el campo de Scan Type seleccionar MRM.

e En el campo de Time (min), ingresar el tiempo de retencidn del compuesto de
interés. Pueden ingresarse varios segmentos o ventanas de monitoreo, es decir, el
tiempo de retencién para la adquisicidon de varios analitos.

e En el campo Gain establecer el valor de la ganancia, puede ser en el rango de 1-10.

e Dar click en la casilla del Data Saved.

e En la region superior derecha del display, Scan Segments ingresar el nUmero de
filas de acuerdo con la cantidad de iones que se van a monitorear en ese segmento
de tiempo a través de los iconos ==5 ., En el campo Compound Name ingrese el
nombre del compuesto que va a monitorear. En el campo de ISTD, seleccione la
casilla si va a utilizar estandar interno. En el campo de Precursor Ion ingrese la
masa m/z del ion que desea monitorear. En el campo de MS1 Resolution seleccione
la resolucion Wide (1,2 uma). En el campo Product ion ingrese un valor de m/z del
ion producto proveniente del ion precursor que desea monitorear. En el campo MS2
Resolution seleccione la resolucion Wide (1,2 uma). En el campo Dwell (min)
puede establecer un valor de 50 y en campo de CE (eV) ingrese el valor de la energia
de colisién para realizar la fragmentacién en la cdmara de colisiones.

Nota: la energia de colision debe ser optimizada a fin de obtener la mayor
abundancia de la reaccion o transicion.

e En la regidn inferior derecha del display se muestra la opcién de Full Scan
parameters, si desea puede habilitar la adquisicidon simultdnea de MRM y Scan,
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dando click en la casilla Enable. Tenga en cuenta que esto podria disminuir la

sensibilidad para la deteccién de los analitos.

Finalmente dé click en OK y guarde los cambios en Methods > Save.

Figura 41. Parametros para operar el MS en el modo MRM.
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Fuente. Propia (2024)

6.5.8. Creacion de la secuencia para inyeccion automatica de las muestras.

La creacion de la secuencia de andlisis se hace mediante el meni Sequence del
Instrument control. También puede acceder a través de los iconos graficos como se
muestra en la Figura 42.

Figura 42. Ruta de acceso para la creacion de secuencias de analisis.
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Fuente. Propia (2024)
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La secuencia puede ser creada por modificacion del archivo default. Desde el menu

Sequence seleccione Load Sequence o el icono & y abra el archivo de default,
default.sequence.xml.

Para abrir el archivo dar click en el menlu Sequence>Edit Sequence o desde el icono
W, Aparecerd la tabla de secuencia como se muestra en el Figura 43.

Figura 43. Tabla de secuencia de analisis.
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New Swplet) » X | @ @) | Took ~

SRR

|
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Fuente. Propia (2024)

En el campo Name, ingrese el nombre de la muestra, puede contener hasta 30
caracteres. No se debe incluir /, *, (,) o espacio preferiblemente guion al piso.

En el campo Vial ingrese la posicidn del vial en la bandeja del automuestreador ALS.
En el campo de Method Path seleccione la carpeta donde se encuentra guardado el
método.

En el campo Method File, seleccione el método que se encuentra dentro de la
carpeta del Method Path.

En el campo Data Path, seleccione la carpeta donde seran guardados los archivos
generados durante la corrida cromatogréfica.

En el campo Data File, ingrese el nombre con el que quedara guardada la muestra.
En el campo Type seleccione el tipo de muestra.

En el campo Level opcionalmente seleccione el nivel de concentracion de la curva de
calibracion desde menor a mayor concentracion. Solo aplica para el tipo de muestra
seleccionado como calibrante.

En el campo DI ingrese el factor de dilucion de la muestra. Dado el caso en el que
no se haya realizado dilucién ingrese el valor de 1.

En el campo de Vol. Ingrese el valor del volumen de inyeccidén, en el caso en que
desee modificar el del método.

Los campos Sample Prep P, Sample Prep, Tray Name, no es necesario
modificarlos. Son utilizados en caso de preparacidon de muestras in situ. El equipo del
Laboratorio de Calidad ambiental del IDEAM, no utiliza esta configuracién.
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e En el campo Comment, se puede adicionar informacion de las muestras. Tener en
cuenta que esta informacion no puede ser modificada después de la corrida de la
muestra.

Guardar la secuencia. Ir al menu de Sequence > Save Sequence As. Ingresar el
nombre de la secuencia inicialmente con la fecha de creacién. Registrar el Afio, mes, dia
y nombre de la secuencia.

Después de crear la secuencia se recomienda realizar la simulacién para verificar los
datos y el espacio disponible en el disco duro del equipo. Vaya al menu Sequence >
Simulate sequence. Ingrese el nombre del operador y verifique la ubicacion de la
carpeta donde quedaran guardados los datos, es decir, el Data file Directory. Dar click
en Simulate sequence. Revisar que toda la informacidn esté correcta y que la ubicacion
de las muestras esté de acuerdo con el nimero de la secuencia. Recuerde que si el
automuestrador, no encuentra el vial en la posicidon de la bandeja que fue programada,
la secuencia se detendra.

Llenar los frascos de solvente A y B, dispuestos en la torre de inyeccién automatica.

Una vez verificado los datos y posiciones de los viales, se puede proceder a ejecutar la
secuencia. El software correra la secuencia que esta actualmente cargada en la memoria.
Seleccionar desde el menu del Instrument Control la opcion Sequence > Run
Sequence. Es necesario que de click en el botén Run Sequence para que la secuencia
arranque. Nota: si da click en OK, la secuencia no sera ejecutada.

Verificar que se realice la primera inyeccidén para asegurarnos que la secuencia se ejecute.

Inyeccién individual. El software permite realizar una inyeccién individual sin necesidad
de ejecutarla desde la secuencia. En este caso, la muestra sera corrida con el método
que se encuentra cargado en el MassHunter Acquisition. Para comenzar, desde el
Instrument Control, haga click en Method>Run method. Seleccione la ubicacion en
donde desea que se guarde el Data File, ingrese el nombre de la muestra, posicién del
vial. Finalice dando click en OK and run method.
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6.5.9. Analisis cualitativo a través del software MassHunter

Inicialmente se realizard una breve descripcién de la interface del Qualitative Analysis
MassHunter Version B.0700 SP2. Este programa permite realizar el analisis
cromatografico, ademas de la identificacion de sustancias por el espectro de masas.
Dentro de los manuales del equipo, se encuentra disponible un DVD y la memory Stick
el manual del eFamiliarization, que cuenta con los manuales con interface grafica muy
didactica para usuarios del software Qualitative y Quantitative.

Para ingresar al software dar doble click en el icono disponible para
MassHunter Qualitative Analysis software en el DESKTOP del
computador. Alternativamente, vaya al menu de inicio del computador
Programs > Agilent > MassHunter WorkStation > Qualitative Analysis.

Al comenzar, se abrira el programa con el disefio inicial o /layout de default que contiene
las ventanas como se muestra en la Figura 44.

Figura 44. Interface del software Qualitative Analysis MassHunter.
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Fuente. Propia (2024)
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El software de Qualitative Analysis MassHunter se divide en cinco areas definidas en
el estandar del layout. En primer lugar, el Data Navigator lista los archivos de datos
abiertos, los cromatogramas extraidos, los espectros, y los compuestos asociados con el
archivo de datos. La ventana del Chromatogram window muestra los cromatogramas
definidos y los cromatogramas de iones extraidos (EIC, Extracted Ion Chromatogram) o
de MS/MS. El Method Explorer permite seleccionar una funcidn y luego utilizar el Method
Editor para establecer los parametros para esa funcién que desea.

Para abrir el archivo vaya al menu File>Open Data File, véase Figura 45. Seleccione
el archivo que desea abrir. La ruta de acceso para los Data file generados después de la
corrida cromatografica es D:\MassHunter\GCMS\1\Data. Deshabilite la casilla de Load
Result data para tener el archivo madre sin que se guarden las modificaciones. Dar click
en Open.

Figura 45. Ruta para abrir los Data File desde el software Qualitative Analysis.
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Fuente. Propia (2024)

El panel del Data navigator muestra los Data files que son abiertos dentro del Qualitative
Analysis software. El usuario puede seleccionar la informacién del cromatograma que
desea observar en el panel del Chromatogram Window. Asi, informacion asociada a ese
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data File como el cromatograma de la corriente idnica total reconstruida o TIC, pueden
ser seleccionadas o deseleccionadas en las casillas de checkbox, véase Figura 46.

Figura 46. Panel del Data Navigator del software Qualitative Analysis.
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Fuente. Propia (2024)

region del cromatograma o del espectro de masas, realice el zoom

dando click con el botén derecho en la ventana y arrastre el cuadro alrededor de los datos
que desea ampliar o dando click derecho sobre el eje y arrastre para hacer zoom. Utilice
los botones de escala automatica para devolver los datos a la escala inicial, véase Figura

47.

Figura 47. Ampliacion de regiones dentro del cromatograma, zooming.
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Fuente. Propia (2024)
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Extraccién de cromatogramas. El Qualitative Analysis software abre inicialmente el
cromatograma de iones totales o TIC. Ademas, permite realizar la extraccion de otro tipo
de cromatograma dependiendo del método de adquisicion utilizado. Para realizar este
procedimiento, puede dar click derecho sobre el cromatograma y seleccionar Extract
Chromatograms, también puede acceder a esta opcién a través del menu
Chromatograms disponible en la parte superior de la interface. En seguida, se abrira el
cuadro de didlogo en donde podra seleccionar el tipo de cromatograma de desea extraer,
las opciones se muestran en la Figura 48.

Nota: cuando seleccione la opcién de cromatograma de ion extraido (EIC), debe ingresar
en el campo m/z value (s) los iones m/z que desea extraer. Finalmente haga click en
OK.

Figura 48. Extraccion de cromatogramas.
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Fuente. Propia (2024)

Superposicion de cromatogramas. Para realizar la superposicidn o Overlaid de los

cromatogramas seleccione en icono de la barra de herramientas del panel de
Chromatograms Results como se muestra en la Figura 49. Si desea separarlos, haga

N
click en el icono Z.‘

Pagina 52 de 74




Instructivo manejo del cromatdgrafo de gases acoplado al Versién: 05
detector de masas de triple cuadrupolo AGILENT GC Fecha: 03/07/2025
IDEAM 7890B/QgqQ 7000D

6 Servicios Laboratorio de Calidad Codigo: SLC-1013

Figura 49. Superposicion de cromatogramas.
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Fuente. Propia (2024)

Integracion de los picos del cromatograma. Para realizar la integracion, dar click derecho
en el cromatograma, seleccionar Integrate Chromatograms o desde el panel de
Method Explorer en el campo de Chromatogram seleccionar Integrate (MS) en el
caso de adquisicion por Scan o también puede ser utilizado Integrate (MS/MS) para
integrar datos adquiridos por MRM. Se abrird la caja de didlogo de/ Method Editor, en
el cual se recomienda utilizar como el tipo de integrador en el campo Integrator

») Integrate Chromatogram ~ , véase Figura

Selection la opcion Agile o Agile 2. Dar click en >
50.

e Para ver la tabla de resultados haga click en el menu View>Integrations Peak
List, icono .

e Para integracién manual haga click en el icono Iil

e Para quitar picos que no necesito que estén integrados. Desde el Method
Explorer en la opcién Integrate (MS) o Integrate (MS/MS), seleccione el
Integrator Selection, puede ser Agile 2, y en la ventana de Peak Filters, ajuste
los eventos de integracién de modo que integre solamente sus picos de interés.
En este caso podria ajustar el pardmetro de la altura de los picos en el campo
Filter on, seleccionando Peak Height. Establezca el filtro segun la area relativa
0 absoluta (Absolute area or Relative area).
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Figura 50. Integracion de areas en picos cromatograficos.
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Fuente. Propia (2024)

Eficiencia de la columna. Es posible evaluar la eficiencia de la columna a través del calculo
de nimero de platos tedricos de una determinada sustancia usando el System Suitability
disponible en la caja de didlogo del Method Editor.

El procedimiento consiste en abrir el archivo corrido en Full Scan con la sustancia a
analizar, seleccionar desde el panel del Method Explorer la opcion Integrate (MS),
seleccione el Integrator Selection como Agile 2 e integre el pico de interés como se
explicod en la Seccion 8.9.8. Después seleccione la pestafia Suitability. Habilitar la casilla
Enable system suitability calculations. En el campo de Pharmacopeia, seleccione
United States Pharmacopeia (USP). En el campo Column void time ingrese el
tiempo muerto en minutos (min). En el campo Column Length la longitud de la columna
en centimetros (cm), véase
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Figura 51. Después vaya al panel de Method Explorer>Reports>Common
Reporting Options. En Templates, seleccione System Suitability report. El reporte
gueda guardado en la carpeta del Data File de la muestra. Evalué el niumero de platos
tedricos de acuerdo con el historial. Si se presenta un variacién aproximada del 30% del
valor inicial, es probable que la columna esté desgastada y sea necesario cambiarla.
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Figura 51. Eficiencia de la columna, System Suitability.
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Fuente. Propia (2024)

Calculo de la relacién sefal/ruido. El procedimiento para calcular la relacidon sefal/ruido
o Signal to noise (S/N) puede ser realizado desde el panel de Method Explorer. Desde
el campo Chromatogram, seleccione la opcidon Calculate Signal-to-Noise. En seguida,
se abrird la caja de didlogo del Method Editor. En el campo Signal definition seleccione
Height. En el campo de Noise definition seleccionar ASTM o Auto-RSM. Se
recomienda utilizar la opcion Auto-RMS para el calculo de S/N. Dar click en la opcién
Automatic noise region detection. En el campo Desired length ingresar el valor de

0,1 min. Véase

Figura 52.
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Figura 52. Calculo de la relacion seial/ruido.
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Fuente. Propia (2024)

Extraer espectro de masas. Es necesario realizar el analisis en el modo de operacién de
Full Scan para obtener los espectros de masas. Desde la barra de herramientas del panel

de Chromatogram Results, dar click en el Peak Selector icono y seleccionar el
pico de interés. Después dar click derecho sobre el pico y seleccionar Extract Peak
Spectrum, véase Figura 53.
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Figura 53. Extraer espectro de masas.
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Fuente. Propia (2024)

Extraer background del espectro. Selecciono la regidén del background que se desea
extraer, dar click derecho. Seleccionar Extract MS Spectrum to background. Después
ir al espectro de masas dentro del panel del MS Spectrum Results, dar click derecho y
seleccionar Move to background Spectrum. En seguida, vaya al cromatograma y
extraiga el espectro de masas del pico o la regiéon en la que desea substraer el
background. Haga click derecho sobre el espectro de masas y seleccione Substract
Background, como se muestra en la Figura 54. De esta forma el espectro estara mas
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limpio y libre de algunas sefiales del ruido de fondo que afectan la identificacién del
compuesto.

Figura 54. Extraer background del espectro de masas.
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Fuente. Propia (2024)

Identificaciéon de compuestos. Primero se debe configurar la busqueda con la libreria NIST
2014, disponible en el Laboratorio de Calidad Ambiental del IDEAM. Desde el panel del
Method Explorer, dar click en el campo Identify Compunds y seleccione Search
Library. Luego, se abrira la caja de didlogo del Method Editor. En |la seccion de Library
seleccion, adicione la libreria dando click en el boton Add Library y escoja la libreria
NIST14, haga click en Open. Establezca como valor de Score el 80 %. En seguida en el
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campo del Search Opcién S“""“"""'”“"‘”""O dar click sobre la flecha = y seleccionar
la opcidon Search Library for Spectra, véase Figura 55. Por tanto, cada vez que se
desee buscar el compuesto de acuerdo con el espectro de masas, se puede dar click
derecho sobre el espectro y seleccionar Search USING NIST MS Program.

Figura 55. Identificacion de compuestos con la libreria NIST 2014.
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Fuente. Propia (2024)

6.5.10. Analisis cuantitativo a través del software MassHunter

El Quantitative Analysis MassHunter Version B.07.01 SP2 permite realizar la
cuantificacion de un lote de muestras a través de la creacion de un método de analisis.
Dentro de los manuales del equipo, se encuentra disponible un DVD y la memory Stick
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el manual del eFamiliarization, que cuenta con los manuales con interface grafica muy
didactica para usuarios del software Qualitative y Quantitative.

Para ingresar al software dar doble click en el icono disponible para
MassHunter Quantitative Analysis QQQ en el DESKTOP del L=

: , L QQQ
computador. Alternativamente, vaya al menu de inicio del computador St

Programs > Agilent > MassHunter WorkStation > QQQ Quantitative
Analysis.

Nota: existen varias versiones del software para analisis cuantitativo, si la adquisicién
de datos se realizé en el modo de operacion de Full Scan o SIM, seleccionar el icono del
MS Quantitative Analysis. Por otro lado, si el analisis fue realizado en el modo de
operacidon de MRM utilice el QQQ Quantitative Analysis.

Al comenzar el QQQ Quantitative Analysis, se abrira el programa con el disefio inicial o
layout de default que contiene las ventanas como se muestra en la Figura 56. La
creacion del método de cuantificacion es realizada en pasos sucesivos, a saber: (1) crear
lote, (2) adicionar muestras, (3) verificar informacion, (4) crear método, (5) analizar el
lote y (6) correcciones y reporte. A continuacidon seran descritos los procedimientos para
realizar actividades.

Figura 56. Interface del software Quantitative Analysis MassHunter
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@ | ¥ |Name|DataFile Type| Level| Acq. Date-Time
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Concentration

Fuente. Propia (2024)
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Crear lote. Para crear un nuevo lote seleccione File > New Batch o dar click en el icono

4. En seguida busque el directorio o carpeta que contiene los data files del lote que
desea analizar. Ingrese el nombre del lote en el campo File name y después seleccionar
el botén Open, como se muestra en la Figura 57.

8.10.4. Adicionar muestras. Seleccionar File > Add Samples. Se abrird la caja de
didlogo del Add Samples. Seleccione las muestras, calibrantes, controles, entre otros,
data file que va a analizar (véase Figura 57). Use Browse to Copy Samples para
adicionar muestras de otros directorios o carpetas en este lote de andlisis, dar click en
OK.

Figura 57. Creacion del lote y adicion de muestras.

BBt i G o o G

|

Fuente. Propia (2024)

Verificar informacion. El software generara una tabla del lote (Batch Table), con los data
file a analizar como se muestra en la Figura 58. Se debe corregir la informacién de tabla.
Seleccionando los calibrantes, el nivel del calibrante, las muestras, controles, blancos,
segun el tipo de muestra.

Figura 58. Tabla del lote de analisis.
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B Agilent MassHu
File Edit View Analyze Method Update Library Report Tocls Help

O & || B2 | GE AnalyzeBatch ~| @ : Layout B EY B8 B [A Reston

Batch Table

Sample: & Mix 2.5 ppb ~ g
m i Name

Sa
Data File Type |Levd
» Mix 2_5 ppb | Mix 2_5 ppb.Df| Cal [~] 1

Sample Type: <All>

Acq. Date-Time
811/2017 3:35 PM

Mix5ppb | Mix5ppbD f| CallCal |2 8/11/2017 4:49 PM
Mix 10ppb | Mix10ppb.D [ Cal — |3 81172017 6:02 PM
Mix25ppb | Mix25ppb.D | Cal  [4 8112017 7:15 PM
Mix50ppb | Mix50ppb.D [ Cal  [5 8/11/2017 8:29 PM
Mix 100 ppb | Mix 100 ppbOf Cal [ 6 81172017 9:42 PM

Fuente. Propia (2024)

Crear método. Seleccionar Method > New > New Method from Acquired MRM Data.
Como el método es nuevo primero se debe editar. De modo que debe seleccionar Method
> Edit, véase Figura 59.

File Edit View Analyze |Method | Update Library Report Tools Help

Figura 59. Crear método de analisis cuantitativo por MRM.

. e Edit View Analyze [Method | Update Library Report Tools Help
i - 1
D e | |G| New » | 5 New Method from Acquired MRM Dat... | | & d|& |6 B
| open » New Method from Acquired Scan Data. 1 Table »
Sample: [#] Mix2.5pph  Append » | NewMethod from Acquired Scan Data with Library Search, - @ s wmples ] Mix2.5 ppb| Append b
- 2 Edit F10 New Method from Acquired Chromatographic Data.. = =0 ‘ I
ame > 3
o Val te New Method using Manual Setul
K2 Emb ] o = P 1L Name nante 3
x5orb |18 New Method from File... %2 8 ppb [1
x 10 ppb ix 5 ppb
ix 25 ppb = x 10 peb Save As..
x50ppb [ B Exit F11 ix 25 ppb
100 ppb | | xS0 peb |54 1
Method Setup Tasks » ix 100 ppb
Manual Setup Tasks » Metbod Seippas) D
Outlier Setup Tasks » MantialSetiipllasis b
et R Outlier Setup Tasks v
Advanced Tasks ,
Copy Calibration Levels To.
Average Calibration Replicates.
Create Levels from Calibration Samples
Import Calibration Levels from File...

Fuente. Propia (2024)

Nota: cuando ya esta el método creado, se puede abrir el método después de crear el
lote. Para esto seleccione Method>Open>Open Method from Existing File, como se
muestra en la iError! No se encuentra el origen de la referencia..
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Figura 60. Crear método de analisis cuantitativo por MRM.

anttative Analysis (for QQQ) - 20171003 20171003 |
BB Agilent MassHunter Quantitative < - 20171003 Prevalidacion_D1 - 20171003 Prevalidacion_D1_OCP.batch.bin C=Trei )
File Edit View Analyze MethodiUpdate Library Report Tools Help
D& H|&8 (6 New » | [A Restore Default Layout

Batch Table [ Open 'I‘b Open Method from Existing Fie... I | x
»

=
Open Method from Bt Batch- | v (&1 IsTD: lﬁ EA 2] " 2

Z Edit F10 Open and Apply from Existing File... \
. JEte-Time
.50 PM

Sample: #| Blanco_Mat Append

@ | v Name
AceOEt_1

10 ppb 24 PM
20 ppb S :58 PM
30 ppb B 32PM
50 ppb | X F11 :05 PM
75 ppb 39 PM
100 ppb. Method Setup Tasks 13 PM

I AceOEt 2 47PM
» Blanco_Matriz. 0:21 PM

' LDM10_Antes Qutlier Setup Tasks 0:55 PM

Manual Setup Tasks

vy v v v

LOWI0Despd  pgancea Tasks 125 M
ec_ 02 Al
AceQEt 3 Co o 2:36 AM

Fuente. Propia (2024)

Editar método. Desde el menu Method, seleccione Edit. En seguida se abrira la interface
del médulo de Method Task. Se realizaran las modificaciones en el panel de Method
Setup Task.

e MRM Compound Setup

Para comenzar se deben crear los compuestos. Seleccionar la pestafia del MRM
Compound Setup. En seguida vaya a la ventana del Method Table, dar click derecho
y seleccionar New Compound. Registrar los datos en la tabla correspondiente a los
parametros del ion de cuantificacion (Quantifier), como se muestra en la Figura 60. En
el campo de Name, ingrese el nombre del compuesto. En el campo de Scan, seleccione
MRM. En el campo de Type, seleccione target. En el campo Precursor ion, seleccione
el m/z del ion precursor. En el campo de Product Ion seleccione el m/z del ion producto.
Recuerde que estos iones corresponden a la transicion del ion de cuantificacion. En campo
RT, ingrese el tiempo de retencion de cada compuesto. Nota: cuando se esté trabajando
con estandar interno (ISTD, Internal Standard) se debe incluir el compuesto en esta tabla
y en el campo Type, seleccione ISTD.

Figura 60. Crear nuevo compuesto.
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ary Report Tools Help

D B | 3 |[GE AnalyzeBatch ~| @ } Layout B EER Restore Default Layout

Method Tasks ~ X | Method Table | |
New / Open Method | Time Segment: 4 <All> ~ = | Compound: [$a] <4> v [%] | Reset Table View
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e i 7
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Enﬂler Setup Yas!‘sr | 254 Resst Sort
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nced Ta: I 2 Arrange Compounds By »
259 [ & New Compound v
1 F¥ New Qualifier
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A New Calibration Level
05 X Delete Del

Copy Calibration Levels To...
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Average Calibration Replicates...
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Collapse All ->00

0.0
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zf‘ (&, Print Preview... 2 83
e Properties... = =

Fuente. Propia (2024)

e Retention Time Setup
El siguiente paso es editar el tiempo de la ventana de visualizacion de cada compuesto.
En el panel del Method Task, seleccionar la opcion Retention Time Setup, después
desde el panel del Method Table, en el campo RT Delta establecer una variacion de 0,5
minutos a partir tiempo de retencién para cada analito (véase Figura 61).

Figura 61. Segmento de tiempo de retencion.

File Edit View Analyze Method Update Library Report Tools Help
A & 3|8 |0E AnahzeBach | @ [ Lyou B DB B @ Restore Default Layout

Method Tasks « x [Method Table
New / Open Method Time Segment: 4 <All> v | Compound: [] Clorotalonil v [®] | ResetTable View
Workflow e | J
Method Setup Tasks Name DataFile Type [ Level [ Acg MethodFile | Acq. Date-Time
i i 1 1 1172017
. MRM Compound Setup | Mix 2_5 ppb [Mix2 5ppb.D | Cal [ | Metodo EPA MR.. [811/2017 3:35. |
ifi
[4C Retention Time Setup I Guaiter : — . :
= Name [ 75 | Trension Scan Type RT _ |LeftRT Delta | RightRT Delta | T Delta Units
EZ 1STD Setup » [ Clorotalonil 2638-> 167 RM Target 10500, 500 Minutes
32 Concentration Setup Propanil 217.0-> 161 RM Target 11300 500 500 | Minutes
Clorpirifos 196.9-> 168. RM Target 13.700| 500 500 § Minutes
& Qualifer Setup Endosulfan alfa 24105205 RM Target 16,600 500 500 | Minutes
S Calibration Curve Setup Endosulfan beta 2410205 RM Target 19,400 500 500 | Minutes
[ Globals Setup —

‘ Save / Exit

Fuente. Propia (2024)

e ISTD Setup
En el caso, en que se esté realizando cuantificacién con estandar interno, se debe
seleccionar el ISTD para cada analito. Desde el panel del Method Task, seleccionar la

Pagina 65 de 74




5 Servicios Laboratorio de Calidad Codigo: SLC-1013

Instructivo manejo del cromatdgrafo de gases acoplado al Versién: 05
detector de masas de triple cuadrupolo AGILENT GC Fecha: 03/07/2025
IDEAM 7890B/QqgQ 7000D

opcidon ISTD Setup. Después, vaya a la ventana del Method Table. En el campo ISTD
Compound Name, escoja el ISTD para cada analito. En el campo de ISTD Flag,
seleccione la casilla para activar el ISTD para el analito. En el campo ISTD Conc, ingresar
la concentracion del estandar interno.

Caso contrario, si no se va a utilizar el estandar interno, no se deben realizar
modificaciones en esta seccién. Un ejemplo de esta configuracion se muestra en la
Figura 62.

Figura 62. Configuracion del estandar interno.

BB Agilent MassHunter @
File Edit View An;

O & d|& stch ~| @ : Layout: fF BE B A Restore Default Layout
Method Tasks ~ X [Method Table

New / Open Method Time Segment: 4 <All> v = | Compound: [&] Clorotalonil v [®] | ResetTable View
Workflow Sample

Method Setup Tasks
#{_ MRM Compound Setup

Level Acq. Method File | Acg. Date-Time

I Liiciodo FPA B |212017 222

Scan Type ISTD Compound Name | ISTD Flag | ISTD Conc. | Time Reference Flag
arget <None> ] B

arget
arget
arget
M arget

3|35|35|35|3

Endosulfan beta 241.0 -> 205.

& Globals Setup

Fuente. Propia (2024)

e Concentration Setup

Para editar la seccién de las concentraciones de los calibrantes del método, se debe
realizar en varios pasos. Desde el panel del Method Task, seleccionar la opcion
Concentration Setup. Después realice las modificaciones desde la ventada del Method
Table.

(I) En primer lugar, se deben crear los niveles de la curva de calibracién. Ir a la tabla del
método y dar click derecho sobre la regién del nombre del compuesto. Posteriormente,
seleccione la opcion & New Calibration Level y repita el proceso para cada nivel de la
curva que desea incluir. Inmediatamente, se generara la tabla de la calibracién. Nota: el
software permite crear hasta 10 niveles de calibracién, véase Figura 63 .

(IT) Después ingrese un prefijo para el nivel de la calibraciéon en el campo Level. Se
recomienda ingresar el mismo dato que se incluyd en la creacion del lote (véase Figura
58). De esta forma, el software utilizara la respuesta del area cromatografica del Data
File respectivo a ese nivel para realizar la curva.

(III) En el campo Conc., ingrese la concentracion de cada uno de los niveles de la curva
en orden creciente.
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(IV) Desde la Tabla del Quantifier, en el campo Units, puede seleccionar las unidades de
concentracién en ng/mL, pg/L o pg/mL.

Figura 63. Concentracion de la curva de calibracion.

6 8 B 0 () [ sesee ot s
< x

Fuente. Propia (2024)

(V) Si las concentraciones de los niveles de calibracidn de todos los analitos son las
mismas, puede copiar los datos para los demas compuestos. Vaya al menu de la ventana
del Method Table, dar click derecho. Después seleccionar Copy Calibration Levels To,
en seguida seleccionar los compuestos que desea que tengan la misma concentracidn en
los niveles de calibracion, dar click en OK, como se muestra en la Figura 64. Nota: si la
cuantificacion es realizada con ISTD, debo adicionar el mismo nimero de niveles de la
curva, pero todos en la misma concentracion, porque el ISDT es adicionado a la muestra
y a todos los niveles de la curva en la misma cantidad.

Figura 64. Copiar los niveles de concentracion de calibracion
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Fuente. Propia (2024)

e Qualifier Setup

En este paso, se deben adicionar las transiciones MRM de los iones de confirmacidn para
cada compuesto. Por tanto, desde el panel del Method Task, seleccionar la opcidn
Qualifier Setup. En seguida vaya al panel de navegacion del Method Table. Seleccionar
el nombre del compuesto al que va a adicionar la transicién y dar click derecho sobre
este. Posteriormente seleccionar la opcién Z New Qualifier, véase iError! No se
encuentra el origen de la referencia..

En la tabla del Qualifier seleccionar las masas de los iones (m/z), de cada transicion de
la reaccién. Asi,por ejemplo, se debe seleccionar el Precursor Ion y Product Ion para
cada transicion. En el campo de Relative Response (Rel. Resp.) ingrese la relacion del
area del ion de confirmacion (Qualifier) en porcentaje (%) con relacién al area del ion
de cuantificacién (Quantifier). En el campo de Uncertainty, ingrese el porcentaje de
incertidumbre en la relacién del area del Qualifier y Quantifier, el software establece
por default un valor del 20%). Repita este procedimiento para cada uno de los analitos.

Figura 65. Seleccion de transicion de la reaccion del ion de confirmacion
(Qualifier).
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FX Qualifier Setup | Precursor lon Product lon Transition Rel. Resp. Uncertainty | Area Sum g Fill Down
% Calibration Curve Setup 3 2658 P30 265852310 | 840] 200 P} o
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=
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Save As. X Delete Del
Exit Copy Calibration Levels To...
| Manual Setup Tasks Average Calibration Replicates...
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| Advanced Tasks

Fuente. Propia (2024)

Expand All

Para finalizar la creacion del método se hace la validacidn. Por tanto, desde el panel del
Method Task, vaya el menu del Save/Exit y seleccione la opcién # Validate. El
software verificara que el método de cuantificacion contenga todos los datos necesarios
en los campos requeridos para ejecutarse correctamente. Si todo esta correcto,
aparecera el cuadro de didlogo en donde indica que no fueron encontrados errores, como
se muestra en la iError! No se encuentra el origen de la referencia.. Por el contrario,
si es detectado algun error la lista de errores aparecera en la parte inferior debajo de la
ventana de Compund Information. Guarde el método de cuantificacién en Save as.

Figura 66. Validacion del método de cuantificacion creado.
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o | e
Los errores encontrados en la validacion del
‘método apareceran aqui.

Fuente. Propia (2024)

Analizar el lote. Después de verificar y salvar el método. Se debe dar click en Exit. El
programa le preguntara si desea aplicar este método al lote. Seleccionar Analyzed>OK,

véase Figura 67.

Figura 67. Analisis cuantitativo del lote.
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Fuente. Propia (2024)

El software analizara el lote y retornara a la interface del panel de navegaciéon del Batch
Table, en donde calculara la ecuacion de la curva de calibracién y la concentracion de
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las muestras incluidas en el lote, véase Figura 68. Si desea adicionar mas muestras para
analizar en el lote. Vaya a File> add simple. En este caso se debe analizar el lote de
nuevo, dar click en el icono ™ *™"=5" " verificar los resultados de tiempo de retencidn,
relacion de darea del ion de cuantificacién y el ion de confirmacién en todos los
compuestos, realizar correcciones con integracion manual del area del pico cromatdgrafo
cuando sea necesario, curva de calibracién. Guarde el analisis cuantitativo del lote antes
de salir, incluso para generar el reporte, vaya File > Save Batch.

Figura 68. Correcciones y verificacion de resultados.

Batch
Table con
resultados

Curvade
Calibracién

Fuente. Propia (2024)

Generacion de reporte. Después de analizar el lote y verificar los resultados, se guardan
los cambios y se genera el reporte seleccionando Report > Generate. En seguida, se
abrird el cuadro de didlogo del Generate Editor, véase iError! No se encuentra el
origen de la referencia..
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Figura 69. Generar reportes en el Quantitative Analysis Software QQQ.
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Fuente. Propia (2024)

Seleccionar el Report Folder o carpeta donde se guardara el reporte desde el botdén
Browser. Luego en el campo del Report method edite el tipo de reporte que se va a
generar dando click en el botén Edit. Se abrird una caja de didlogo como se muestra en
la iError! No se encuentra el origen de la referencia.. Para comenzar a establecer
las caracteristicas del reporte se debe adicionar el Template. Para esto haga click en el
boton Add Template, seleccione el archivo desde el directorio siguiendo la ruta
D:\MassHunter\Report Templates\Quant\en-us\letter\Parts_Grafics. En esta carpeta
aparecen varias opciones de modelos de reporte. Se puede seleccionar el
QuantReport_ESTD_Complete. Continue configurando los demas campos del Report
Method Edit.

e En el campo de Report mode seleccione Batch.
e En el campo destination file, establecerd el nombre de default del template, se
recomienda no cambiar.

e En el campo de Publish Format, seleccionar el XLSX que corresponde al formato en
Excel.

e En el campo de Printer, seleccionar la impresora en PDF CutePDF Writer.

e En el campo Open published File dar click en la casilla para que abra el archivo
después de generarlo.
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Dar click en Save & Exit. En seguida retornara al cuadro del Generate Report.
Seleccionar Generate report now > OK. Esperar hasta que se genere el reporte.

Figura 70. Editar y adicionar el modelo para crear el reporte del lote.

[ Report Method Edit (Quantitative Analysis) - testm _— . ; [ =Ac

File Edit Tools
N H 2@ |a
Templates | Resuts | Graphics settings

Template Report mode Destinationfie _ Publishfomat  Language Page Size Printer Open publishedfie _Post Process Audt Trail Report

» D:\MassHunter\Rep..plete_B_06_00.xitx - Batch v | QuantReport_ES... | XLSX CutePDF Wii... v [} <None> v B

Seleccionar el Modo de Nambre Formato Formato
modelo del reporte excel PDF
reporte defecto del (XLSX)
Template

|

El nombre se puede modificar, preferiblemente sin
espacios, incluir guion al piso.

[ savesbnt | Edt ]

Fuente. Propia (2024)

6.6. Documentos relacionados

e HARRIS, D.C.; (2010), Quantitative Chemical Analysis, Eighth Edition, W. H. Freeman,

EE. UU., p.p. 502-594.

MILLER, J.M.; MCNAIR, H.M., (1997), Basic Gas Chromatography, John Wiley, Canada,
p.p. 3-5.

STASHENKO E.E.; MARTINEZ J.R., (2010), GC-MS: Mas de un Analizador de Masas,
épara qué? Scientia Chromatographica, 2(4), 25-48.

Agilent Technologies, Inc., Concepts Guide, Agilent 7000 Series Triple Quadrupole
GC/MS System, Manual Part Number G7000-90031, Second Edition, October 2011.
Agilent Technologies, Inc. Operating Manual, Agilent 7000/7010 Series Triple
Quadrupole, Manual Part Number G7003-90046, First Edition, September 2016.
Agilent Technologies, Inc., Student Manual, Agilent Triple Quadrupole GC/MS
Techniques and Operation, Course Number R1718A, Volume I, II, 2009.

Agilent Technologies, Inc., eFamiliarization for 5977B MSD, 7890B GC, MassHunter
Acquisition and MassHunter Data Analysis, Part Number G4600-60404.
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7. Control de cambios

VERSION

FECHA

DESCRIPCION

01

14/12/2017

Creacion del documento

02

06/07/2018

Se sintetiza la redaccién del documento, para esto se
reescribe el fundamento del método y se elimina graficos
y la seccién de creacion del método.

03

21/10/2020

Nueva version producto de la actualizacién de la
documentacién del Sistema Integrado de Gestion

04

21/10/2024

Se actualiza todo el documento a nueva plantilla del SGI.
Se incluyen todas las imagenes del software para cada
etapa y se desarrolla con especificidad el contenido para
que sea mas completo el instructivo.

05

03/07/2025

Se actualiza el Formato de acuerdo con el memorando
enviado por la OAP memorando 20251100097283
lineamientos para la actualizacion documental en el
marco de la implementacion del aplicativo suite vision. El
codigo pasa de M-S-LC-1013 a SLC-1013.
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